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1 About This Guide

Using This Guide
This user guide provides instructions for installing, operating and maintaining
Objet30 3D printing systems. It explains how to use features, and provides
practical examples to guide you as you use the system.
The text and figures in this guide are based on the Objet30 3D printer, printer
software version 33.2 and Objet Studio software version 9.2.
This document is meant to be used with Objet30 3D printers, running
software version 33.2, and with Objet Studio software version 9.2.
This guide assumes that—
• all the hardware, software, and network components of your Objet30
system are installed, configured, and operating correctly.
• the operator has a working knowledge of the Windows® PC platform.

For More Information
Visit http://www.stratasys.com/ to download additional documents for this
printer, including documents in other languages. Also available on this site:
details about consumables and support contacts.
If you have any questions or comments about the way information is
presented in this document, or if you have any suggestions for future editions,
please send a message to c-support@stratasys.com.
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Terms Used in This Guide
Build tray

In Objet Studio software: The surface displayed on the screen
that represents the actual build tray in the printer.
In the printer: The surface upon which models are produced.

Cleaning fluid

Cleanser for flushing material feed tubes and the printing block,
used to completely remove Model and Support material from
the system before loading another type of material in the
printer and before long-term shutdown. The cleaning fluid is
supplied in standard material cartridges.

Client/user workstation

The workstation on which software is installed for preparing
build trays for production on PolyJet printers. (There is no limit
to the number of client workstations in the local network.)

host/server workstation

The workstation that interfaces directly with the Objet30
printer and is typically positioned next to it.

Job Manager™

The part of Objet Studio software that manages production jobs
before they are sent to the PolyJet printer.

Model material

Material used for building models.

Objet Studio™

Software that prepares files for printing on Stratasys PolyJet
printers.

OBJTF

The extension of a file that contains all of the information
needed for a model-printing job on PolyJet 3D printers. An
objtf file is used by Objet Studio to send a print job to a PolyJet
3D printer.

OBJZF

The extension of a compressed “wrapper” file containing all of
the files used in an Objet Studio build tray. Using objzf files, a
printing job can be saved as a single file, for convenient storage
and transfer.

Objet™ printer

The Stratasys 3D printer referred to in this guide.
The computer inside the Objet30 printer that operates it.

Printer computer
Printer interface

The GUI (graphical user interface) used for controlling the
Objet30 printer.

Printer software

Software running on the computer inside the Objet30 printer,
that controls all printer operations.

Resin

The base substance from which photopolymer printing
materials are made for use in Stratasys PolyJet printers. In
Objet Studio and printer-application screens, “resin” refers to
cartridges of model and support materials.

SLC

A file type used with Objet Studio, containing bitmaps of
individual slices of the object.
A file type used with Objet Studio software.

STL
Support material

DOC-34022 Rev. D

Material used for supporting the structure of models during
production.
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2 Safety

Safety Features

Cover Interlock Switch

Stratasys 3D printers are designed to comply with CE and FCC
standards. They are equipped with the following safety features:
The power supplied to the UV lamp and the motion motors is
turned off when the cover is opened.

Warning
Do not defeat (override) the interlock switch. Doing so could
result in serious personal injury. If the interlock switch does not
function correctly, do not use the printer, and contact your service
provider.
Safety Lock

Warning
Do not defeat (override) the safety lock. Doing so could result
in serious personal injury. If the safety lock does not function
correctly, do not use the printer, and contact your service provider.

UV Screening

The transparent section of the cover blocks harmful UV
radiation, allowing the operator to view the model as it is being
made.

Circuit Breaker

The power to the printer is turned off in case of electrical
overcurrent.
Note: The circuit breaker is only accessible to service
personnel.

Grounded Chassis

The chassis of the printer is grounded, to prevent electrical
shock.
Note: The power outlet must be properly grounded, in
accordance with the local electric code, to provide this
protection.

DOC-34022 Rev. D
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2 Safety

Figure 2-1

Front and back views of the Objet30 printer

If the Objet30 3D printing system is not used as specified in this guide, the
safety features may not provide adequate protection.
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Symbols and Warning Labels
This following table lists the warning labels located on or in Objet30 printers.
Warning Symbol

Meaning

Location

Comments

Hazard (general)

On the name plate on the Read the instructions in
back of the printer.
this document before
operating the printer.

Hot surface

On the print block.

Risk of burns. Do not
touch this surface after
printing.

High voltage

Near the UV lamp
connector.

Risk of electric shock.

Near the power-supply
enclosures.

DOC-34022 Rev. D

Ultraviolet
radiation

Near the UV lamp.

Risk of injury from
ultraviolet radiation.

Moving parts

On top of the printing
assembly.

Risk of injury from moving
parts.
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Safety Guidelines
The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the system. If the system is not operated as specified,
the user's safety may be compromised.

Printer
Installation

➢ Installation and removal of the printer should only be done by qualified
service personnel.
➢ Connect the printer (and the UPS unit) to the electric outlet using a power
cord that is safety-certified.
➢ The electric outlet should be easily accessible, near the printer.
➢ Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose the
operator to serious danger from electric shock.
➢ The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:
“The machine must be connected to a grounded power outlet.”
❒ FI: Laite on liitettävä suojakoskettimilla varustettuun pistorasiaan.
❒ NO: Apparatet må tilkoples jordet stikkontakt.
❒ SE: Apparaten skall anslutas till jordat uttag.
❒ DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som
giver forbindelse til stikproppens jord.
➢ Leave a minimum of 20 centimeters between ventilation openings and
walls or other objects.

Printer
Operation

➢ The printer should only be operated by persons trained by a Stratasys
customer-support representative.
➢ All persons operating or maintaining the printer should know the location
of first aid and emergency equipment and how to use it. Never block
access to this equipment.
➢ Keep fingers and other body parts clear of the printer cover when closing
it.
➢ Never attempt to open the printer cover while it is working.
➢ Never override the interlock safety switch.
➢ If the interlock safety switch ever fails, do not use the printer.
➢ Several parts of the printer remain extremely hot even after it has stopped
operating. Avoid touching the UV lamp and the print block.

DOC-34022 Rev. D
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2 Safety

The UV lamp used in the printer emits dangerous radiation.
➢ If the UV lamp remains on when the printer cover is open, do not stare
directly at the UV light. Shut down the printer and call your Stratasys
service provider.

Printer
Maintenance

➢ Service operations should be performed only by qualified personnel who
have been instructed in relevant safety precautions.
➢ Notify co-workers and those who have access to the Objet30 system
before beginning non-routine and hazardous work.
Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

Model and
Support
Materials

Model and Support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all Model
and Support materials used by the Objet30 system are handled in sealed
cartridges. Normally, operators of the printer should never be directly exposed
to hazardous materials. In the unlikely event of a leak or spill, follow the
instructions that are included with the printing-material cartridge used.
➢ Store Model and Support materials indoors, in a dry area with adequate
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.
➢ Keep Model and Support materials away from areas where food and drink
are stored, prepared and consumed.
➢ Uncured printing material is considered a hazardous substance, requiring
certain precautions when directly handling it. To prevent skin irritation,
wear neoprene or nitrile gloves. If there is any chance that Model and
Support materials might splash into the eyes, wear safety goggles.
Prolonged direct contact with printing materials can cause an allergic
reaction.
➢ When handling UV-cured models that may not be completely cured on the
surface, common latex gloves are adequate.
➢ To prevent respiratory irritation, ventilate areas where Model and Support
materials are used. The ventilation system should totally replace the air at
least four times per hour.
➢ Clean up Model-material and Support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl alcohol
(IPA), followed by soap and water. Dispose of the absorbent material in
accordance with local regulations.
➢ Do not wash contaminated clothing at home; clothing should be
professionally laundered.
➢ Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing material
may re-expose the user when these items are worn.
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2 Safety

UV lamps used by the printer to cure printing materials contain a small
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling
mercury vapor, and ventilate the room. If the lamp ruptures (breaks) during
operation, leave the room and ventilate it thoroughly for about 30 minutes.
Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that prevents
the generation of mercury vapor, such as a syringe, packing tape or paper.
Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container. Dispose of the container in accordance with
applicable regulations.

DOC-34022 Rev. D
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First Aid for Working with Printing Materials
In general, try to avoid direct contact with uncured printing material. If skin
or eyes come into contact with it, wash the area immediately and thoroughly
with water, and follow these first-aid instructions.
The Material Safety Data Sheet (MSDS) that accompanies printing
materials contains important safety information. Keep this in an accessible
place where these materials are used and stored.

Contact with
Skin

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.
➢ Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.
➢ Do not use solvents to clean skin.
➢ If large areas of skin have been exposed, or if prolonged contact results in
blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.
➢ Avoid the accidental transfer of printing material from the hands to other
areas of the body, especially to the eyes.
➢ If protective cream was used, do not reapply it until the skin has been
completely cleansed.

Contact with
Eyes

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.
➢ Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.
Wearing contact lenses when handling liquid printing materials is not
recommended. If the liquid splashes into the eyes when contact lenses are
worn, immediately remove the lenses and flush the eyes with water.
➢ Clean and disinfect the contaminated lenses.
➢ Do not wear contact lenses until eye irritation disappears.

Ingestion

DOC-34022 Rev. D

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.
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2 Safety

Vapors from printing materials can be irritating to the respiratory system. If
respiratory irritation occurs, expose the victim to fresh air immediately.
➢ If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.
➢ Seek medical attention immediately.
➢ Keep the victim warm but not hot.
➢ Never feed anything to an unconscious person.
➢ Oxygen should be administered by authorized personnel only.

Waste Disposal
Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste (uncured
printing material).
Printing ➢ When removing the waste container from the Objet30 printer, wear
Materials
neoprene or nitrile gloves.
➢ To prevent liquid waste from splashing into the eyes, wear safety goggles.
➢ Liquid waste from the Objet30 printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and disposed
of in a manner that prevents human contact with it and contamination of
water sources.
➢ Empty Model-material and Support-material cartridges contain residue of
their contents. Some leakage of this residue may occur through the broken
cartridge seal. Therefore, handle and store empty cartridges with care.
➢ Do not attempt to reuse empty cartridges, and do not puncture them.
➢ Dispose of used cartridges and waste containers in accordance with local
regulations.
➢ Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.
UV Lamps UV lamps used by the printer to cure printing materials contain a small
amount of mercury, and are considered “Universal Waste.” Recycle or discard
used lamps in accordance with applicable regulations.
Broken lamps:
After ventilating the area, use protective gloves and carefully remove spilled
mercury with a method that prevents the generation of mercury vapor, such
as a syringe, packing tape or paper. Place the broken lamp, mercury and
contaminated materials in an air-tight, non-metallic container. Dispose of the
container in accordance with applicable regulations.
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3 Introducing the Objet30 3D Printing System

Welcome to Objet Studio

Figure 3-1 The Objet30 3D Printer

Work Configurations
The Objet30 3D printing system can be set up as a single-station system or as
a multi-station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files for production. A server, typically next to
the 3D printer, sends jobs to the printer for production.
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Figure 3-2 shows the Objet30 printer set up in a multi-client configuration.

Figure 3-2 Multi-client network configuration
When jobs are sent to the printer, Job Manager, on the server computer,
arranges them according to their priorities, model-material type, and other
factors. In multi-workstation configurations, the operator of the server—
typically the production administrator—has total control over the jobs sent to
the printer, and can prioritize jobs, delete jobs, review job history and reprint
jobs.

DOC-34022 Rev. D

3-3

Objet30 User Guide

3 Introducing the Objet30 3D Printing System

Source Files
PolyJet printing systems produce three-dimensional models designed with
most CAD tools and some other 3D applications. Supported file formats:
• STL
• SLC
Objet30 systems feature the capability of producing different types of model
files simultaneously.

STL Files

STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as a
collection of triangles.
For example, a square can be described as two triangles; a cube (six squares)
as 12 triangles. Curved surfaces need more triangles to describe them. The
higher the tolerance (for smooth surfaces), the more triangles are needed.
The result is that high-quality object descriptions mean very heavy files.
Most CAD software can export STL files. The Objet30 system utilizes these
files for building models (rapid prototyping), and also for directly making
molds for mass-producing items.
STL files can be ASCII (text) files or binary files. The content of the ASCII file
begins with “solid” and ends with “end-solid” (both lower case). Between
these keywords is a list of the triangles that describes the faces of the solid
model. Each triangle defines a single normal vector directed away from the
solid’s surface, followed by its X-Y-Z coordinates. These are expressed as
Cartesian coordinates and are floating-point values. The coordinates of all
triangles should be positive and should fall within the volume of the model.

SLC Files

DOC-34022 Rev. D

SLC is short for Stereo-Lithography Contour. SLC files describe twodimensional contours of the three-dimensional models. These contour lines
are polylines.
SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in Objet
Studio may be different than the solid-object images displayed from STL files.
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Printing Materials
Objet30 printers produce models by jetting thin layers of printing materials
on the build tray, until the complete model is formed. Two types of material
are used in this process:
• Model material—which makes up the finished model
• Support material—which fills gaps and spaces in the model during
printing, and is removed after printing
For up-to-date information about PolyJet printing materials and their
properties, go to http://www.stratasys.com/materials/polyjet.

Storage

Materials used for printing models with Objet30 printers are made of resins,
which are composed of reactive monomers and oligomers. Although printing
materials are supplied in sealed, UV-proof cartridges, care must be taken
when storing and handling them. Follow these guidelines to protect operators
and the environment, and to ensure optimum results.
• To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances (such
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet
printing materials.
• When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.
• Store material cartridges indoors, in a dry area with adequate ventilation,
between 15–25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to
heat or flames, cartridges might burst or ignite.
• Signs of premature polymerization in material cartridges include bulging,
leaking, the emission of heat, and unusual odor. Exposure to heat can
cause resin to gel in the cartridges.
• Make sure that material cartridges are stored in accordance with all local
regulations and other applicable requirements.

Shelf Life

Materials used for producing models have a limited shelf life. The expiry date
on the label is valid when properly stored in an undamaged, unopened
cartridge. Always rotate your stock, so that the cartridge with the earliest date
is used first.

Exposure to
Light

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.
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Safety
Before being cured, resins are hazardous materials. To prevent possible health
Considerations hazards, follow these precautions regarding printing materials:
• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled.
• Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored
without precautions.
You can find more safety information about resins in:
l
l

Disposal

"Safety Guidelines" on page 2-5
"First Aid for Working with Printing Materials" on page 2-8

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.

Work Environment
Extreme heat and humidity conditions can adversely affect the operation of
the Objet30 3D printer. Use ventilation or air-conditioning systems, if
necessary, to keep the work area within the following ranges:
• 18°–25°C (64°–77°F)
• 30%–70% relative humidity

Workstation Requirements
The requirements for client computers running PolyJet Studio are listed in
the Objet30 Site Preparation Guide.
To download this document, go to: www.stratasys.com/customersupport/customer-resource-center/polyjet-customer-documents
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Preparing Files for Use with PolyJet 3D Printing Systems
Before using design files with Stratasys 3D printing systems, make sure that
they are in a supported file format. (For an explanation of these file formats,
see "Source Files" on page 3-4.)
You can print several models or parts at the same time, after arranging them
on the build tray in Objet Studio. The following are the maximum dimensions
for a single model printed on the Objet30 printer:
• With glossy finish—
X-axis: 294.00 mm (11.57 inches)
Y-axis: 192.00 mm (7.55 inches)
Z-axis: 148.60 mm (5.85 inches)*
* OrthoDesk printers—100.0 mm (3.94 inches)
• With matte finish—
X-axis: 293.00 mm (11.53 inches)
Y-axis: 191.00 mm (7.52 inches)
Z-axis: 148.30 mm (5.83 inches)*
* OrthoDesk printers—97.9 mm (3.85 inches)

Converting
CAD Files to
STL Format

This procedure may vary slightly, depending on the CAD software used, but
the following instructions generally apply.
To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.
2. In the Save As dialog box, open the Save As Type drop-down list and
select *.STL.
3. Click Options and set the following parameters:
❒ Total Quality—approximately 0.01 mm (deviation tolerance / lineardimension tolerance)
❒ Detail Quality—approximately 5° (angle tolerance)
Note: Lowering these values produces more accurate models, but results in
larger files and longer loading and processing times. For this reason, it is
generally not recommended that you use lower values.
4. In the file format option, choose binary or ASCII. (Both binary and ASCII
formats can be used in Objet Studio. However, binary files are smaller, so
this option is recommended.)
5. Click OK or Save.
After converting the model files, it is recommended that you check them for
defects in an STL-repair application (such as Magics™, by Materialise®)
before opening them in Objet Studio and producing the model.
For more information, search for "CAD to STL" on www.stratasys.com.
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When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before being
saved as SLC files. Considerations for suitable model orientation are explained
in "Manual Positioning" in Chapter 3 on page 5-21.
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Objet Studio Software
The Objet Studio program for the Objet30 3D printing system consists of two
main screens:
• Tray Settings / Model Settings
• Job Manager
Tray Settings / Model Settings
In the Tray Settings and Model Settings screens, you prepare source files for
production in Objet30 3D printers. Objet Studio offers you a wide variety of
file-preparation options, but always consists of the following basic procedure:
1. Placing one or more objects on the build tray
2. Positioning the object(s) on the tray
3. Configuring object and tray parameters
4. Saving the tray configuration as an objtf (tray format) file
5. Sending the objtf file to the Objet30 3D printer for production
Using Objet Studio to perform these tasks is described in detail in Chapter 5,
"Using Objet Studio".
Job Manager
The Job Manager screen is different for client workstations and for the
computer connected directly to the Objet30 3D printer.
• In Objet Studio installed on the directly-connected computer (server), the
Job Manager screen displays the queue and status for all jobs sent to the
3D printer by the server itself and by all client computers on the network.
All jobs displayed can be edited and manipulated.
• In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server from
that computer. Only these jobs can be edited and manipulated from the
client computer.
Client computers can be connected, via the local network, to PolyJet 3D
printers, but only to one at a time. The Job Manager screen displays the
status of the 3D printer to which the client is currently connected.
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How to Install Objet Studio
Objet Studio software is installed during printer installation. This section is
provided in case you need to reinstall Objet Studio, or install it on a remote
(client) computer.
The Objet Studio setup wizard guides you when installing this software. Objet
Studio is installed on the printer-server (“host”) computer, but it can also be
installed on remote, “client” computers and on computers used to prepare
files for printing models, or for training and demonstration purposes. During
installation, you choose to install either the printer-server (“host”) application
or the client application.
To install Objet Studio software:
1. Connect the USB flash drive (supplied with the printer) to a USB port.
2. On the USB flash drive navigate to the Objet Studio installation file, and
run it.
3. If you are installing an Objet Studio upgrade, make sure that your printer
is compatible with it by checking the list displayed.

Figure 4-1 Objet Studio compatibility check
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4. To install Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.
If you click Yes, the following screen should appear.

Figure 4-2 Objet Studio installation wizard—Welcome screen
5. Click Next to begin installation.
6. In the Select Features screen, select the required installation option.
Select Objet Studio for a server computer—
❒ if you are installing Objet Studio on the server (“host”) computer—the
computer directly connected to an Objet30 printer.
❒ if you are installing Objet Studio on a standalone (off-line) computer.
Select Objet Studio for client workstations if you are installing Objet Studio
on a “client” workstation—a remote computer that prepares print jobs and
then sends them to a server computer.

Figure 4-3 Objet Studio configuration selection
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7. In the Select Installation Folder screen, verify the destination folder and
click Next.
It is recommended that you do not change the default destination folder.
Click Disk Space to check the space in the destination folder.

Figure 4-4 Objet Studio installation-folder selection
8. In the Confirm Installation screen, click Next to begin installation.
9. In the Select Printer Type screen, select the 3D printer used for producing
models and click Next.

Figure 4-5 Printer selection
l
l
l
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For Alaris30U printers, select Objet30
For Alaris30 Pro printers, select Objet30Pro
For Objet30 Dental Prime, select Objet30 Prime
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Installation begins and a progress bar appears, showing the progress of the
installation process.

Figure 4-6 Installation progress bar
When installation is complete, the final InstallShield wizard screen
appears.

Figure 4-7 Final installation screen
10. Restart the computer to complete the software installation.
The installation process ends when the appropriate icon(s) appear on the
computer desktop:
• Objet Studio
• Stop Job Manager (for servers and standalone stations)

Objet30 Dental For Objet30 Dental Prime printers, install the Objet30 Dental Prime software
Prime Version update (available on the USB flash drive supplied with the printer)
immediately after installing Objet Studio.
To install the software update:
1. Connect the USB flash drive (supplied with the printer) to the computer.
2. Right-click the Start button and select Explore (or use any other method
for displaying files on the computer).
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3. In the USB flash drive folder, navigate to the sofware section and run the
Objet30 Dental Prime Software Update for Objet Studio.
4. When the following screen appears, select the number appropriate for
your operating system and press Enter.

Figure 4-8 Windows command screen during software update
5. When the process is finished, press any key to close the Windows
command screen.

How to Uninstall Objet Studio
If there is ever a need to uninstall the Objet Studio software, do not attempt
to do so from the Windows Control Panel. (This does not completely remove
all software components.) Instead—
➢ From the Start menu, select All Programs > Stratasys > Uninstall Objet
Studio.
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Launching Objet Studio
After you install Objet Studio, a launch icon
appears on the Windows
desktop. Open the application by double-clicking this icon, or by selecting
Objet Studio from the Start menu.

Open Objet Studio by double-clicking the
selecting Objet Studio from the Start menu.

Windows® 7
Security
Warning

icon on your desktop, or by

Depending on the User Account Control settings in Windows® 7, you might
see the following warning when opening Objet Studio.

Figure 5-1 Security Warning
If you click Yes, Objet Studio opens. However, this warning message will
appear each time you open the program, unless you change the User Account
Control settings.
To prevent the warning message from appearing again:
1. Click the link at the bottom of the security warning dialog box (Change
when these notifications appear).
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2. In the User Account Control Settings screen, move the slider to Never
notify.

Figure 5-2 Changing the User Account Control settings
3. Click OK.
4. In the following dialog box, click Yes.

Figure 5-3 Confirming the change in the User Account Control settings
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When Objet Studio opens, the Tray Settings screen appears, showing an
empty build tray.

Figure 5-4 Objet Studio opening screen
The Objet Studio interface consists of two main screens:
• Tray Settings—for arranging models and preparing them for printing.
• Job Manager—for monitoring and managing print jobs.
This screen is described in "Monitoring and Managing Print Jobs" on page
5-64.
Each screen is controlled by menus and icons on its own ribbon. An
additional ribbon, Model Settings, displays controls for configuring and
manipulating selected models.
Objet Studio anticipates your workflow by displaying and enabling the options
relevant to your current task. For example, when you first open Objet Studio,
the Model Settings ribbon is disabled until you place a model on the build
tray. Similarly, options available from the standard toolbar menus are enabled
or disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in
"Customizing Objet Studio" on page 5-50.
Instructions for using the commands for preparing models for production
and sending jobs to the printer, appear later in this chapter.

Figure 5-5 Tray Settings ribbon

Figure 5-6 Model Settings ribbon
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The following table lists the Tray Settings and Model Settings ribbon
command groups, and shows when they are enabled, and where they appear.

Purpose

When enabled

Setting display colors.

Always.

Selecting perspective
and zoom level.

Models are on
the build tray.

Choose to select a
plane.

Models are on
the build tray.

Change the perspective
of the active pane.

Models are on
the build tray.

Assigning printing
material.

Build tray is
empty.

Tray
Model
Settings Settings
Ribbon Ribbon

Models are not
selected.
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Undoing or redoing
actions.

After an action
or object
selection.

Estimating the amount
of printing materials
required.

Build tray is not
empty.

Opening and saving
files.

Models are not
selected.

Placing model files on
the build tray.

Always.
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Purpose

When enabled

Pre-build/build
commands.

Models are on
the build tray.

Setting model
dimensions.

A model is
selected.

Cutting, copying,
pasting and deleting
models.

A model is
selected.

Moving, rotating and
resizing models.

A model is
selected.

Assigning model finish
and setting support
strength/“hollow.”

A model is
selected.

Tray
Model
Settings Settings
Ribbon Ribbon

Setting a model’s unit of A model is
measure (millimeters or selected.
inches).

To quickly identify an icon, move the cursor over it to display a tooltip. The “Undo” and
“Redo” tooltips change to reflect your last Objet Studio action.

After activating some of the ribbon commands (by clicking them), they remain active until
you click another button or until you press the Escape key.
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Clicking the
icon in the upper-left corner opens the Objet Studio
Commands menu. This menu displays basic application commands and
options.

Figure 5-7 Objet Studio Commands menu
The Options button opens a dialog box for customizing Objet Studio.

Figure 5-8 Options dialog box

Model Tree
Pane
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The Model Tree pane lists the objects placed on the build tray. By default, the
pane “floats”— that is, you can move it to another position on the screen and
resize it. Alternatively, you can fix its position at the left of the application
window, and even hide it.
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Preparing Models for Production
Model preparation involves the following basic steps:
1. Place objects on the build tray.
2. If necessary, manipulate the object’s orientation and position.
3. Select the material and model finish.

OBJDF Files:
Overview

An objdf file describes both the geometry of a single object and the material,
and finish required to print it.
You can use this file format to save a group of separate objects on the build
tray as one unit, together with their relative positions and material.
Further explanations of objdf files, and their features, appear throughout this
chapter.

Model Files

To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
two ways: You can place objects on the build tray in several ways:
• by inserting individual stl files.
• by pasting objects that you copied to the Windows clipboard.
If you know what type of model material will be used to produce the models,
make sure it is selected from the material drop-down menu.

Figure 5-9 Model material selection toolbar
Note: It is not necessary to select the Model material now, but it is
recommended—each type of material has unique characteristics that may affect
the valid positioning of objects on the build tray. The material selected can also
affect printing time—printing with Objet VeroClear takes longer than printing with
other materials.

Placing Objects To place an object on the build tray:
on the Build
1. Open the Insert dialog box—
Tray

❒ From the Object menu, select Insert.
or—
❒ On the Tray Settings ribbon, click
or—

.

❒ Right-click on the build tray, and select Insert from the context menu.
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The Insert dialog box appears.

Figure 5-10 Insert dialog box
2. In the Look in field, display the appropriate folder.
3. In the Files of type field, select the file type to display.
4. Select the desired file, and make sure that it appears in the File name field.
If the Preview check box is selected, the object is displayed in the dialog
box, as shown in Figure 5-10.
The Model Settings ribbon is displayed when objects are placed on the
build tray.
5. Select any of the following options, as required:
❒ Units—Millimeters or inches for the object’s units of measure.
The 3D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters or
inches when inserting an object. Otherwise, the size of the object on
the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see "Measurement Units" on page 5-26.
❒ Number of copies—How many copies of this object to place on the
build tray.
❒ Orient Automatically—Automatically orient objects on the build tray for
efficient model building.
Note: The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each axis.
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These dimensions correspond to the virtual “bounding box” surrounding the
object see Figure 5-36 on page 5-32).
6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

Figure 5-11 Default screen layout
The Model Settings ribbon is displayed when objects are placed on the
build tray.
If the object is over a certain size, the Loading Placed Elements dialog box
appears.

Figure 5-12 Loading Placed Elements dialog box
You can speed up the opening of large files by changing the Large Files
settings—see "Loading Large Files" on page 5-36.
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Opening objdf Files
Before placing objdf files on the build tray, Objet Studio must extract the
component stl files together with information about their relative position
and model materials. To do this, Objet Studio creates a folder with the same
name as the objdf file, in the same location.
If you are opening an objdf file, the Insert dialog box also includes a
Materials field that shows the object’s printing material assignment (see
below).

Figure 5-13 Insert dialog box (objdf file)
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Opening Objet You can open trays that were saved as objtf files. (Saving objtf is described in
Tray Files
"Saving and Importing Build Trays" on page 5-49).
To place an object saved as an Objet Tray File (objtf) file on the build tray:
1. From the File group, click
or—

.

From the Objet Studio Commands menu
The Open dialog box is displayed.

, select Open.

Figure 5-14 Objet Tray File Open dialog box
2. Select the desired file, and make sure that it appears in the File name field.
If the Preview check box is selected, the object is displayed.
3. Click Open.
Objet Studio opens the tray file.
The objtf file is actually a file containing instructions for printing—which stl
files to print and their position on the build tray. Because the objtf file
references the stl files used, they must remain in the same file location as
when the objtf file was saved.

DOC-34022 Rev. D

5-14

Objet30 User Guide

5 Using Objet Studio

STL file loading If there are identically named stl files in more than one location, you need to
preference ensure that the correct component stl files are linked to the objtf file. For
example, if there are identically named stl files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you can
set the default location from which files are loaded.
To set the Load Order:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands menu

, click Options.

2. In the Options dialog box, display the Settings tab.

Figure 5-15 Options dialog box, Settings tab
3. Under Load Search Order, select an option:
❒ Local—to load files from the location where they were last saved.
❒ Original—to load files in their original location.
4. Click OK.
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You can access common commands for working with objects on the build
tray with the convenient Model Toolbar and context menus.

Model Toolbar Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

Figure 5-16 Model Toolbar
The table below describes the Model Toolbar icons.
Icon

Description
Applies a matte finish to the model.

Applies a glossy finish to the model.
Opens the Advanced Properties dialog box for setting the Grid
Style and the Hollow option.
Enables dragging an object (see page 5-27).

Opens the Transform dialog box for changing the object’s
position and scale.
Toggles the Lock Model Orientation setting.

Right-click If you right-click on an object, a pop-up context menu is displayed from
model menu which you can also select the model finish, change its position and scale, and
set the Grid Style and Hollow options.
You can also create a Quick Access toolbar with your most commonly
used icons grouped together. See "Creating a Quick Access Toolbar" on
page 5-50.
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To manipulate an object on the build tray or assign characteristics to it
(building style, for example), you must first select the object. You select an
object by clicking it, either on the tray or in the model tree. Its image on the
build tray changes color (to light blue, by default) and its name is highlighted
in the model tree. You can select multiple objects by drawing a box around
them with the mouse cursor, or by pressing the Ctrl or Shift keys while
clicking additional objects.
Alternatively, select or de-select objects using the following Edit menu
commands:
• Select All
• Invert Selection
• Undo Select object

Figure 5-17 Edit menu

Copying and
Pasting
Objects

If you need to duplicate objects on the build tray, you can insert the same
object from its file more than once. An easier way, however, is to copy and
paste the object. You can copy objects from the build tray or the model tree.
The objects copied remain in the Windows clipboard until you paste them
onto the build tray.
You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another one.
However, Objet Studio allows only one tray to be open at a time. For each
build tray you need to work with (at the same time), you must open a separate
Objet Studio window, by running the application again (from the Windows
Start menu).
Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. Copying and pasting also allows you to use objects
already configured on previously-used build trays for newer projects.
You perform the Copy and Paste commands as in other Windows
applications:
• from the right-click context menu.
• by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).
The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:
• You can specify the number of duplicates to place on the build tray at
once.
• You can set the distance, on each axis, between the duplicate objects.
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• You can manipulate mirror images of the original object, and flip them on
selected axes.

Figure 5-18 Paste Special dialog box

Surface Finish

Models can be printed with a matte or glossy surface finish. To create a matte
finish, the printer surrounds models with a thin layer of support material.
To set the model finish:
1. Select the model.
2. Select Matte

or Glossy

in one of the following places:

❒ Model Settings ribbon, Options group
❒ Model Toolbar
❒ right-click context menu (when selecting the model)
You can configure Objet Studio to distinguish between objects’ surface finish
on the build tray by color. To configure how Objet Studio displays objects, see
"Setting Object Colors" on page 5-36.
Before placing objects on the build tray in Objet Studio, you should pay
attention to the material selection settings on the Tray Settings ribbon.
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Positioning Objects on the Build Tray
To produce models efficiently and with the required finish, it is important to
carefully position objects on the tray. Objet Studio supports the automatic
positioning of objects. However, you should check to make sure that the
objects are orientated optimally for your needs, according to the
considerations explained in "Manual Positioning" on page 5-21.
Two things that affect the positioning of objects on the tray are orientation
and placement. You can let Objet Studio determine the optimum orientation
and position, or you can control them.

Automatic
Orientation

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation when
placing an object on the build tray.
To place an object on the build tray without automatic orientation:
➢ In the Insert dialog box, make sure Orient Automatically is not selected.

Figure 5-19 Orient Automatically option disabled
You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time
you place an object on the build tray. To do this, see "Default Settings" on
page 5-58.

DOC-34022 Rev. D

5-19

Objet30 User Guide

Automatic
Positioning

5 Using Objet Studio

After placing several objects on the build tray, you can let Objet Studio
arrange them before printing. This ensures that the objects are positioned
properly, and that they will be printed in the shortest time and with a
minimum of material.
To automatically arrange objects on the build tray:
➢ On the Tray Settings ribbon, click
.
or—
From the Tools menu, select Automatic Placement.
The effects of automatic positioning are shown in the figures below.

Figure 5-20 Tray before objects are properly arranged

Figure 5-21 Tray arrangement after applying Automatic Placement
l

l

DOC-34022 Rev. D

For best results, arrange the tray with Automatic Placement,on the
TraySettings ribbon, even if you inserted the objects with the Orient
Automatically option.
The physical characteristics of each type of Model material you use can
affect the positioning of objects on the tray. Therefore, select materials
before running Automatic Placement.
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You can change the position of objects on the build tray—even if they were
inserted with the Orient Automatically option. Tools for changing the
position of objects are presented in "Manipulating Objects on the Tray" on
page 5-23.
The orientation of models on the build tray affects how quickly and efficiently
they will be produced by the printer, where and how much Support material
is used, and whether or not model parts will have a glossy finish. Therefore,
you should consider a variety of factors when deciding how to place models
on the build tray, using the following positioning rules.
X-Y-Z Rule
This rule considers a model's outer dimensions.
➢ Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along the
Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.
➢ Any surfaces that come into contact with Support materials become matte.
➢ Since models are built up, on the Z-axis, in 15–36-micron layers (according
to the printing mode), it is very time-consuming to print a tall object.
From this point of view, it is advisable to place the object's smallest
dimension along the Z-axis.
➢ Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in one
pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.
Tall-Left Rule
This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.
➢ Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the build tray, the print heads only have to scan
the model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.
The following rules are based on the fact that Support material is not
required on the top of the printed model.
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Recess-Up Rule
This rule considers models containing surface recesses.
➢ Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.
Fine-Surface Rule
This rule considers models that have one side on which there are fine details
(like the keypad side of a telephone).
➢ The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.
Avoid Support-Material Rule
This rule considers models that have large holes or hollows, open on at least
one side (like a pipe or a container).
➢ It may be advantageous to print a model standing up, so Support material
does not fill the hollow, even though printing the model lying down would
be much faster.
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Manipulating Objects on the Tray
Positioning
When you use the automatic positioning option to arrange objects on the
Objects on the build tray (see "Automatic Orientation" on page 5-19), the objects are
Z-Axis
positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.
In practice, the Objet system prints all models on the build tray on a onemillimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects
on the screen.

To position objects directly on the tray:
1. Select the object.
2. From the Object menu, select Lay On.
To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-22 Options dialog box, Settings tab
2. In the Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):
• When under the tray—The display of objects that are below the build tray is
automatically changed so that the object is at tray level.
• Never—The display of objects that are above or below the build tray is not
changed.
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You can ensure that models do not overlap when you position them on the
build tray, and that they do not extend beyond the tray.
To ensure valid object placement:
1. From the Tools menu, select Constraints Settings.

Figure 5-23 Constraints Settings dialog box
2. Select Dynamic check to identify—
❒ invalid object placement while placing objects—On Drop selected.
❒ invalid object placement after moving objects—While Drag selected.
❒ objects placed beyond the tray’s boundaries—Outside Tray selected.
❒ objects that overlap—Object Collision selected.
Even if you do not use Dynamic Check when placing objects on the build
tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can
also manually check for problems after positioning objects (see "Tray
Validation" on page 5-40).
Note: Remember that Objet Studio calculates the space occupied by an object
including the “bounding box” surrounding it (see Figure 5-36 on page 5-32).
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Using a Grid to Displaying a grid on the image of the build tray can be useful when
Position
positioning objects. To use the grid features, select the following menu
Objects
options.
Menu Option

Result

Tools > Grid

Displays a grid on the build tray.

Tools > Snap to grid

When moving the object, it aligns with the nearest grid line.

Tools > Options > Grid

Enables you to change the grid origin
(X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them—from the
Options dialog box.
To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Figure 5-24 Options dialog box, Grid tab
2. As required, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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3D files contain an object's proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.
To set the measurement units when inserting an object:
➢ In the Insert dialog box, Units field, select Millimeter or Inch:

Figure 5-25 Units field in the Insert dialog box
To change measurement units for a selected object from the Model Settings
ribbon:
1. Open the Units flyout toolbar.

Figure 5-26 Units flyout toolbar
2. Select the measurement units desired.
To change measurement units for a selected object from the standard toolbar:
1. From the Object menu, select Change Units.

Figure 5-27 Model Units dialog box
2. In the Model Units dialog box, change the setting and click OK.
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You can change an object’s dimensions by changing its size on the X-, Y-, and
Z-axes, from the Dimensions group on the Model Settings ribbon.

Figure 5-28 Dimensions on the Model Settings ribbon
• If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.
• After changing a measurement, press Enter or click in another field in the
Dimensions group.
Note: You can change the height of the objects on the build tray only if this is
allowed by the Objet Studio settings (see "Positioning Objects on the Z-Axis" on
page 5-23).
The recommended minimum size for each object on the build tray is
800 mm (on the X-axis) and 130 mm (on the Y-axis). Although smaller
objects can be printed, these minimum dimensions ensure good print
quality.

Repositioning
Objects

You can manually move and rotate an object on the build tray with the arrow
keys, or by dragging it with the mouse.
To manually manipulate an object:
1. Select an object by clicking it on the build tray, or in the model tree pane.
2. Click
on the Model Toolbar, or on the Model Settings ribbon.
A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-29 Manually moving an object
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3. If you click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-30 Manually rotating an object
4. Manipulate the object with the arrow keys or with the mouse.

Using the You can make precise changes to an object by changing the properties in the
Transform Transform dialog box.
Dialog Box
To access the Transform dialog box (when an object is selected):
• Click
on the Model Toolbar or on the Model Settings ribbon.
• From the right-click context menu, select Transform.
• From the Object menu, select Transform.

Figure 5-31 Transform dialog box
To change an object with the Transform dialog box:
➢ Change any of the values, then click Apply to see how the object changes
on the build tray.
Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see how
the object changes on screen each time you click Apply.
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To reset all of the values in the dialog box:
➢ Click Reset.
Note: The object does not change. Any changes previously applied remain.
To undo all changes made with the Transform dialog box:
➢ Click Cancel Actions.
After closing the Transform dialog box, clicking Undo (on the Model
Settings ribbon or from the Edit menu) cancels all changes made with the
dialog box.

Changing an
Object’s
Orientation

There are several methods for changing the orientation of objects on the
build tray.
To rotate an object:
➢ Select the object and use the Object menu options (see also "Repositioning
Objects" on page 5-27).
To re-align an object’s plane:

.
1. On the Tray Settings or Model Settings ribbon, click
or—
From the Tools menu, select Plane Alignment > Select Plane.
2. Click on part of an object on the build tray.
The selected plane is displayed.

Figure 5-32 Aligning by plane
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3. On the Alignment toolbar, click an appropriate icon to change the
alignment.
or—
From the Tools menu, select Plane Alignment, and select an alignment
option.

Figure 5-33 Tools menu, Plane Alignment options
To cancel plane selection after re-aligning objects on the build tray:

➢ On the Tray Settings or Model Settings ribbon, click
or—

.

➢ From the Tools menu, select Plane Alignment > Select Plane.
To flip an object 180 degrees on any axis:
1. Select the object.
2. From the Object menu, select Flip > Flip X / Flip Y / Flip Z.
To make precise changes to the object’s orientation on any axis:
1. Select the object.
2. Display the Transform dialog box (see Figure 5-31 on page 5-28).
3. Change the Rotate parameters for each axis.

Freezing Model If you manipulate an object on the build tray, you can freeze its orientation so
that it does not change when you position it automatically (see "Automatic
Orientation
Positioning" on page 5-20).
To freeze an object:
1. Select an object on the build tray.
2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click .
To unfreeze an object:
➢ Select the object and click
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Display Options
Viewing
Objects

From the View menu, you can change the way objects are displayed. The
default method for displaying models on the build tray is as solid (“shaded”)
objects.

Figure 5-34 Tray and model displayed in Shaded view
The other display options are WireFrame and Points.
To display the build tray in WireFrame view:
➢ From the View menu, select WireFrame.

Figure 5-35 Tray and model displayed in WireFrame view
To revert to the shaded view:
➢ From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions instead of their
shape:
➢ From the View menu, select Display Bounding Box.

Figure 5-36 Model displayed with bounding box
To display the area around objects needed for support material (to produce a
matte finish):
➢ From the View menu, select Display Thickening Box.

Figure 5-37 Model displayed with thickening box
To display the maximum build height:
➢ From the View menu, select Display Tray 3D Box.

Figure 5-38 Tray 3D Box
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To display objects without the build tray:
➢ From the View menu, clear (de-select) the Display Tray option.

Screen Layout

Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.
To change the screen layout:
➢ On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-39 Screen layout icons
❒ Single View
❒ 4 Views

is the default screen layout.
displays perspective, top, front and right views.

Figure 5-40 Single-view screen layout
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Figure 5-41 4-view screen layout

Tray
Perspective

The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.
To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

Figure 5-42 Perspective toolbar
2. Click the icon that represents the desired perspective.
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Tray Positioning To view the tray and models from different directions, you can move the tray
around the screen and change its display angle.
To move the tray in the Objet Studio screen:
➢ Press the mouse wheel while moving the mouse.

Figure 5-43 Tray after moving it in the Objet Studio display
To manually rotate the tray:
➢ Press Alt and press the mouse wheel while moving the mouse.

Figure 5-44 Tray after rotating it upside-down
To view the tray and models from different directions, you can change its
display angle.
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The color of objects on the build tray can indicate how they are printed. Objet
Studio enables you to choose the color display so that you can easily see the
material, and surface of objects.
To choose how colors are applied on the display:
➢ On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

Figure 5-45 Colors display options
Before sending a build tray to the printer, or when you perform tray
validation, Objet Studio checks if there is a problem with the stl files or the
positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see "Tray Validation" on page 5-40).

Loading Large
Files

Very large stl files can be slow to load and may be difficult to manipulate
easily on the build tray. If this is the case, you can display just an image of the
object on the build tray without loading the entire file. The stl file itself is not
changed, and the complete file is sent to the printer.
To display an image of stl files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-46 Options dialog box, Settings tab
2. In the Large Files section, select Load Partial (reduced).

DOC-34022 Rev. D

5-36

Objet30 User Guide

Large File
Manipulation

5 Using Objet Studio

If you need to work with a detailed model that is composed of a large number
of polygons, you can speed up its display and manipulation in Objet Studio by
reducing the number of polygons on the screen. Although this may reduce
the resolution on the screen, it has no affect on the printed models.

Figure 5-47 Object displayed without polygon reduction

Figure 5-48 Object displayed with only five percent of its polygons
showing
To use polygon reduction:
1. From the Tools menu, select Options.
or—
From the Objet Studio Commands menu
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2. In the Options dialog box, display the Display tab.

Figure 5-49 Options dialog box, Display tab
3. Select Enable Polygon Reduction.
4. Select Polygon Reduction (Percent).
5. Enter the percentage of total polygons to display.
When you click Apply, the display changes.
Note: The setting affects the static display (when the object is not being
moved).
6. Set display options when the object is being moved (Display while
changing view):
❒ Bounding Box—A box representing the object’s maximum dimensions
is displayed.
❒ Adaptive Polygon Reduction—Varying degrees of polygon reduction
are applied, as necessary.
❒ Entire Object—No polygon reduction is applied.

7. To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.
8. Click Apply to see the results of the settings without closing the dialog box.
Selecting the Entire Object option cancels polygon reduction.
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Object display The display format affects how quickly objects display. For example, if you
options select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).
To select the object display preference while changing view, and in static view:
1. Select to display objects:
❒ With a Bounding Box (see Figure 5-36 on page 5-32)
❒ With Adaptive Polygon Reduction (changing view only)
❒ With Polygon Reduction (static view only)
❒ Entire Object

2. Click OK when done.

Zoom Options

While manipulating objects, you often need to view them at different zoom
levels.
To change the zoom level:

Figure 5-50 Zoom flyout toolbar
❒ Zoom Object focuses on the selected object.
❒ Zoom Tray displays the whole tray.
❒ Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.
You can also zoom in and zoom out with the mouse wheel.
You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See "Automatic Zoom" on page 5-59.
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Handling Trays
After preparing models on the build tray, you can do the following:
• Test that it can be printed ("validation").
• Calculate the time and material resources needed to print it.
• Send it to the printer for production.
• Save it for later completion or printing.
• Save it as a compressed file for convenient storage and transfer.

Tray Validation Before sending a job to the printer for production, you should check that the
tray is “valid” and can be printed.
Note: Because of the unique characteristics of each type of modeling material,
make sure that the correct material is selected before performing Tray Validation.
To validate that the tray can be printed:
➢ On the Tray Settings ribbon, in the Build Process group, click
.
or—
From the Tools menu, select Placement Validation.
If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

Figure 5-51 Color code
Note: The “Both” color also indicates a problematic stl file.
The validation status appears on the bar at the bottom of the screen.

Figure 5-52 Validation details in status bar
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Printing Modes When preparing models for printing on Objet30 Prime and Obje30
Dental Prime printers, you can choose one of the following quality/speed
settings.
High Quality

High Speed

Draft

Prime

Mode

ü

ü

ü

Dental Prime

ü

ü

HQ (High Quality) Mode—
• Prints models in 15-micron layers, suitable for producing fine details and
delicate items.
• Requires much more time to print most trays, compared to HS mode.
Note: HQ mode is not available when Tango materials are chosen.
HS (High Speed) Mode—
• Prints models in 28-micron layers, suitable for producing most models.
• Requires much less time to print most trays, compared to HQ mode.
Draft Mode—
• Prints models in 36-micron layers, suitable for producing large models and
initial designs.
• Fastest printing mode.
• Most economical printing mode.
Note: Draft mode is not available when Tango materials are chosen.
The quality of models printed in Draft mode depends on many factors and it
may be inconsistent over time. Even printing the same file may produce
different results at different times. If the quality is not acceptable, use HS or
HQ mode.
You select the printing mode in the Tray Materials area of the Tray Settings
ribbon. Change the setting, if necessary, before sending the tray to the 3D
printer.

Figure 5-53 Printing-mode selection
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Objet Studio enables you to calculate the time and material resources needed
for producing trays before sending them to the printer. The time it takes
Objet Studio to perform this calculation depends on the number of objects on
the tray and their complexity. Calculating the production estimate for a full
tray could take up to 15 minutes, depending on your computer’s
specifications.
To calculate the time and materials needed for producing the current tray:
➢ On the Tray Settings ribbon, in the Build Process group, click
.
While the estimate is being calculated, a progress bar is displayed—on the
right side of the status bar (at the bottom of the screen).

Figure 5-54 Estimate progress bar
When Objet Studio finishes calculating the production resources, the
results are displayed in the Estimated Consumptions group on the Tray
Settings ribbon.

Figure 5-55 Production resource calculation

E-mailing
Objet Digital
Files

You can easily e-mail objdf files using Microsoft® Office Outlook®. Sending
objdf files is recommended (instead of stl files) because the size of a file is
typically reduced by more than half. An added benefit is that the objdf file
contains the model-material information for the object.
To e-mail a file:
1. From the Tools menu, select Email Objet Digital File.
Outlook opens with the file attached and Subject details added to the
e-mail form.
2. Enter the e-mail address and send the file.

Printing the
Tray

When a tray is ready to be printed, it is placed in the Jobs Queue. When the
job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the printer.
To send the tray to the print queue:
➢ On the Tray Settings ribbon, Build Process group, click
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If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.
Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors (see
"Tray Validation" on page 5-40), and a warning message appears.

Figure 5-56 Tray validation warning message
❒ To cancel the Build command so you can correct the problem, click
No.
❒ To print the models as they are positioned on the tray, click Yes.
The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See "Monitoring and Managing
Print Jobs" on page 5-64.
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Applying Additional Objet Studio Features
The following topics describe additional features available in Objet Studio:
• Dividing Objects
• Displaying the Cross Section of Objects
• Saving the Screen Display as an Image File
• Saving and Importing Build Trays

Dividing
Objects

You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you produce
only a specific section of a model.
To split an object:
1. Select the object.
2. From the Object menu, select Split.
3. In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its axes,
by entering either exact measurements or the number of parts.

Figure 5-57 Split Object dialog box
4. In Save to Folder, enter the folder name.
5. Click OK.
The composite parts are saved as new stl files with “Part 1,” “Part 2,” etc.,
added to the original file name.
Note: Before printing the newly created stl files, it is recommended that you
check them for defects in an STL-repair application, such as Magics™, by
Materialise®.
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When producing models, support material fills some hollow and empty
sections (see "Manual Positioning" on page 5-21). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or
small/delicate models. For most purposes, the default setting provides
adequate support strength.
To change the strength of the support structure used when printing a model:
1. Select a model on the tray.
2. On the Model Settings ribbon, in the Options group, click
or—
❒ On the Model Toolbar, click
or—

.

.

❒ From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

Figure 5-58 Advanced Properties dialog box
Note: If an object is split into shells, the Advanced Properties enabled vary
with the object selection. If a single element is selected only Hollow is
enabled. If a group of elements is selected only Grid Style is enabled.
3. In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each model
on the tray.
❒ Standard—for models needing average support (most models).
❒ Heavy—for large models needing much support.
❒ Lite—for delicate models needing little support. (This setting makes it
easy to remove the support material.)
4. Click Apply.
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Many objects placed on the tray from stl files are “solid.” This means that,
when printed, the model will be completely filled with model material. Often,
especially with large objects, this is unnecessary. Instead, the model can be
filled with support material, which is less costly. It is also advisable to fill
models with support material when preparing them for investment casting,
since this material burns off more quickly during the process of making the
cast.
Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than 0.5
millimeters.
To use the Hollow feature:
1. Select a model on the tray.
or—
❒ On the Model Toolbar, click

.

or—
❒ From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Figure 5-59 Advanced Properties dialog box
3. Set the shell thickness, in millimeters.
4. Click Apply.
Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.
To inspect, change or cancel the Hollow setting:
1. Select a model on the tray.
2. Access the Advanced Properties dialog box, as above.
3. If you change or cancel the Hollow setting, click Apply.
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The Section feature enables you to view the interior of an object by “slicing” it
on any axis. You can then manipulate the object to inspect the interior from
different angles. This may be important for deciding on the type of support
necessary when producing the model (see "Choosing the Support Strength"
on page 5-45). Displaying an object’s cross section only affects how the tray is
displayed on the screen; it does not change the object itself.
To display a cross section of the tray:
1. From the Tools menu, select Section.
The Section dialog box opens.

Figure 5-60 Section dialog box
2. Select Enable Clipping.
3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that you
see the cross section you want.

Figure 5-61 Left: Whole view; Right: Cross section view after using the
Z-slider
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Saving the
You can save the image displayed in the active viewing screen as a graphic file.
Screen Display
as an
To save the screen display as an image:
Image File
1. Press Ctrl+B.
or—
From the Objet Studio Commands menu
The Save Bitmap dialog box opens.

, select Save Bitmap.

Figure 5-62 Save Bitmap dialog box
2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type drop-down list, and select the file format.
5. Click Save.
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Saving and
Importing
Build Trays

You can save your work in different Objet Studio file formats, depending on
how you want to use them later.

OBJTF Files

objtf files contain instructions to Objet Studio and to Objet30 printers for
displaying and producing the stl files used on the tray. When you save build
trays in Objet Studio, they are saved as objtf files.
Saving in objtf format is useful, for example, if you have not finished
preparing the tray for printing, or if you want to make changes before
printing it again in the future. objtf files are also useful when working from
your company's network, where the STL files are stored.
Note: Because the objtf file references the stl files used, they must remain in the
same file location as when the objtf file was saved.
To save the tray as an objtf file:
➢ In the Tray Settings tab, File group, click

.

To open trays saved as objtf files, see "Opening Objet Tray Files" on page 5-14.

OBJZF Files

To conveniently save all of the files as they are positioned on the build tray,
for storing the job, or for transferring it to another location, Objet Studio
compresses them into one objzf file. To later use the objzf file, the file must
first be expanded in Objet Studio and its component files saved.
Note: If you export an objzf file containing a stl file originally saved as read-only,
you cannot open (import) this objzf file to the folder where the read-only stl file is
saved.
To create an objzf file:
1. From the Objet Studio Commands menu
The Save As dialog box opens.

, select Export Packed Job.

2. Select the folder, set the file name, and click Save.
Note: You can also export a print job as an objzf file from the Job Manager
screen—see "Additional Server Features" on page 5-77.
To open an objzf file:
➢ Double-click on the objtf file.
or—
1. From the Objet Studio Commands menu

, select Import Packed Job.

2. In the Open dialog box, display the appropriate folder and select the file.
3. In the Browse for Folder dialog box, display the folder in which you want
Objet Studio to expand the compressed file, and click OK.
The objtf file and associated stl files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.
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Customizing Objet Studio
You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:
❒ Creating a quick-access toolbar for frequently used commands.
❒ Changing the position of the Quick Access toolbar.
❒ Minimizing the ribbon.
❒ Changing the Objet Studio color theme.
❒ Configuring default settings for objects placed on the build tray.

Creating a
Quick Access
Toolbar

As you work with Objet Studio, you may use certain commands frequently.
You can create a quick-access toolbar to make your work easier.
To create a quick-access toolbar:
1. Above the ribbon tabs, click

.

The Customize Quick Access Toolbar menu opens.

Figure 5-63 Customize Quick Access Toolbar menu
2. Select a command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

Figure 5-64 Quick Access toolbar
To add another command, repeat the above procedure.
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3. To choose from a wider range of commands:
❒ From the Customize Quick Access Toolbar menu (see Figure 5-63 on
the previous page), select More Commands.
or—
❒ Right-click on the Objet Studio Commands icon
, or elsewhere on
the ribbon, and select Customize Quick Access Toolbar.

Figure 5-65 Right-click ribbon menu
The Options dialog box opens.

Figure 5-66 Quick Access Toobar Options dialog box
4. Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.
5. Select a command and click Add.
6. Click OK.
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To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.
To hide the ribbons:
1. Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands menu

.

2. Select Minimize the Ribbon.
The ribbons disappear, but you can temporarily display the ribbon icons by
clicking Tray Settings or Job Manager on the menu bar. When you next
click outside of the ribbon, it disappears again.
To return the permanent ribbon display:
➢ Repeat the steps above to cancel Minimize the Ribbon.

Display Colors You can customize some of the colors used for displaying Objet Studio screens
and for displaying objects on the build tray.
To change the colors used in Objet Studio screens:
1. From the Tools menu, select Options.

Figure 5-67 Display settings
2. In the Appearance tab of the Options dialog box, you can configure the
display.
❒ The Mode selection determines how models appear on the build tray.
The default method for displaying models on the build tray is as solid
(“shaded”) objects. The other options are WireFrame and Points.
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❒ If Shaded is selected, you can display the model on the tray as a seethrough object.

Figure 5-68 Transparent display
❒ Double-click the color patches to customize colors.
❒ The Windows Background Color settings enable you to change the
color behind the build tray—with either a solid or a two-color gradient.
❒ To return to the default display settings, click Default.
Changing Color Objet Studio offers a choice of four background color themes—blue, black,
Themes silver and aqua.

Figure 5-69 Background color themes
To change the color theme:
➢ From the Style menu, select one of the options.
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You can define shortcut keys for frequently used commands.
To define shortcut keys:
1. Above the ribbon tabs, click

.

The Customize Quick Access Toolbar menu opens.

Figure 5-70 Customize Quick Access Toolbar menu
2. Select More Commands.
The Options dialog box opens (see Figure 5-66 on page 5-51).
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3. Click Customize.
The Customize Keyboard dialog box appears.

Figure 5-71 Customize Keyboard dialog box
4. Select command Categories to display all the commands in that category,
for example, all the Model Settings commands.
Current shortcut keys are displayed.
5. Enter the shortcut key in the Press new shortcut key field, and click Assign.
6. If you want to redefine all shortcut keys, click Reset All.
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You can change several Objet Studio settings that affect objects placed on the
build tray.
To change default settings:
➢ From the Objet Studio Commands menu

, select User Preferences.

Figure 5-72 Setting work preferences
• Building Style—see "Surface Finish" on page 5-18.
• Grid Style—see "Choosing the Support Strength" on page 5-45.
• Application Settings:
❒ Lock Orientation—see "Freezing Model Orientation" on page 5-30.
❒ Hollow—see "Hollow"—Filling Models with Support Material on page
5-46.
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Professional Mode Features
Some advanced features of Objet Studio are only accessible in Professional
Mode.
To see the current Objet Studio setting:
➢ Open the Tools menu.

Figure 5-73 Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.
To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.
The following message is displayed, reminding you that the change will
only take effect the next time you open Objet Studio—even though the
check mark next to the Professional Mode option appears immediately.

Figure 5-74 Configuration-change message
2. Close and re-open Objet Studio to use the Professional Mode features.
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You can control the default settings of several Objet Studio features from the
Advanced tab of the Options dialog box.
To display the Options dialog box
➢ From the Tools menu, select Options.
or—
In the Objet Studio Commands menu

, click Options.

Figure 5-75 Options dialog box, Advanced tab
The Advanced tab is only accessible when Professional Mode is active
(see "Professional Mode Features" on the previous page).
Automatic By default, when Objet Studio places objects on the build tray, it orients them
Orientation optimally, for the shortest printing time. If necessary, you can choose to
cancel automatic orientation each time you place an object on the build tray
(see "Automatic Orientation" on page 5-19). In any case, when objects are on
the build tray, you can change their orientation manually (see "Manual
Positioning" on page 5-21.)
To change the default setting so that Automatic Orientation is disabled:
➢ In the Advanced section of the Options dialog box, clear the check box.
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Automatic Zoom When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms in, to display the objects placed on the build tray. This
allows you to carefully inspect and manipulate the objects.
By default, this feature is not enabled. In any case, you can change the zoom
level, as necessary (see "Zoom Options" on page 5-39).

OpenGL Driver The OpenGL driver displays 3D graphics on your screen. There is normally no
Configuration reason to adjust its settings. If you suspect a problem with the way Objet
Studio displays objects, you can use the OpenGL Driver Configuration tool to
check and configure the driver settings.
To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands menu

, click Options.

2. In the Options dialog box, display the Troubleshooting tab.

Figure 5-76 Access to OpenGL Driver configuration
The Troubleshooting tab is only accessible when Professional Mode is
active (see "Professional Mode Features" on page 5-57).
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3. Click OpenGL Driver Configuration.
The dialog box that opens displays details of the pixel format ID (index) for
the window and the memory.

Figure 5-77 OpenGL Driver Configuration dialog box
If you want to display the values and change them, click
. Alternately, you
can select Choose Format and change the values in this dialog box.
To perform a test of the driver configuration and enter the suggested pixel format
ID:
1. Select Choose Format.
2. Click Test.
Objet Studio returns the recommended pixel format ID.

Figure 5-78 Recommended pixel format ID
3. Click OK.
4. In the OpenGL Driver Configuration dialog box (Figure 5-77), select Pixel
Format ID and enter this number.
5. Click Apply.
6. Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance
Objet Studio Help provides on-screen instructions and information, as you
work.
To view Objet Studio Help:
➢ On the standard toolbar, click

and then click Objet Studio Help.

Figure 5-79 Help options
You can also view information on the following subjects:
❒ Troubleshooting opens a list of error messages and their explanations.
❒ Check for Updates checks if you are using the latest Objet Studio
version.

Objet Studio Version, Material Module and Licensed Features
You can view details of the Objet Studio version, the material module
installed, and the features available with your license.
To view details of your Objet Studio installation:
➢ On the standard toolbar, click

and then click About....

Figure 5-80 Displaying Objet Studio details
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About Objet The About Objet Studio tab shows the Objet Studio version number and basic
Studio tab information about your computer.

Figure 5-81 About Objet Studio tab
Materials The Materials Module tab shows details of the material module installed.
Module tab

Figure 5-82 Materials Module tab
• Module version
If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.
• Module date
If a Materials Module upgrade (patch) was installed, the date of its
creation is displayed. If no patches were installed, the Module date is the
date of the Objet Studio version.
• Module properties
If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.
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Feature License The Feature License tab shows the Objet Studio features available with your
tab license.

Figure 5-83 Feature License tab
Click

to expand the details for each feature.

• Modes shows the printing modes available.
See "Printing Modes" on page 5-41.
• Materials shows model materials available.
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Monitoring and Managing Print Jobs
In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on client
workstations and on the computer connected directly to the 3D printer—the
server workstation.
• Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3D printer server from that computer, and it
allows the user to edit only these jobs.
Note: If there are several PolyJet printers on the local network, client
computers can connect to any of them, but only one at a time.
• Objet Studio installed on the computer directly connected to a specific 3D
printer (server), displays the queue and status for all jobs sent to that 3D
printer by the server and by all client computers on the network. It also
allows editing and manipulation of all jobs, and enables re-sending
previously-printed jobs to the printer.
If Objet Studio is not connected to a printer (or printer server), you can
prepare tray files for any PolyJet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.
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The Job Manager screen on the client and server workstations looks
identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.

Figure 5-84 Job Manager screen
The Job Manager screen is divided into panels:
• "Jobs Queue"
• "Printing Progress"
• " History "
• "Available Resources"
• "Material Consumption"
• "Tray Preview"
• "Waste"
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Jobs Queue On the server, the Jobs Queue lists the last 15 jobs sent from client computers.
On client workstations, the Jobs Queue lists jobs sent from that computer to the
printer server.
Information for each of the queued jobs is displayed, including the job status.
Status

Meaning

Waiting

Printing of this job has not started.

Building

Printing of this job is in progress.

Stopped

Printing of this job was interrupted. Printing can later be continued
(Resume) or begun again (Restart).

Error

Errors occurred during the printing of this job, and it was placed in
the Jobs Queue again.

Editing

This job is now being edited in Objet Studio.

Spooling

The job file is being spooled in the printer.

Preprocessing

The 3D printer is readying itself for printing: the cover locks,
print heads warm up and are put in starting position, UV lamp
is turned on, and the build tray level is adjusted.

On Schedule

The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:
• Owner—the computer that sent the job
• Build Time—the estimated building time for the job
• Model Consumption—the amount of model material required to complete
the job, and the amount actually used till now
• Support Consumption—the amount of support material required to
complete the job, and the amount actually used till now
Printing The Time panel shows printing times and the number of slices sent to the
Progress printer.

History The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.
Available The Available Resources panel contains graphic indicators that show the
Resources amount of available printing materials remaining in the printer.1
• Actual—the amount of material used till now
Material
Consumption

• Required—the amount of material still needed to finish the job
Tray Preview The Tray Preview panel displays the build tray view of the job
selected in the Job Queue or the History list.
On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see "Additional Server Features" on page 5-77).

1Objet Studio displays the weight of the printing materials in both cartridges as long as each cartridge contains more than 100 grams of

material. The weight under 100 grams is not calculated and displayed. However, if a cartridge contains less than 100 grams of material,
the printer uses it—as long as the material in the other cartridge weighs more than 100 grams. In any case, the weight of each cartridge
is displayed in the printer application.
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Waste If you move the mouse over the Waste display, the amount of waste in the
container is displayed.

Setting the
Printer
Connection

When your printer is installed, the server computer is connected to that
printer. Normally, there should be no reason to change this connection.
Occasionally, however, you may need to reset the connection, to connect the
server to another printer, or to use Objet Studio in off-line mode (without a
printer connection).
To set (or change) the printer connection:
1. On the Job Manager ribbon, in the 3D Printer group, click

.

2. In the Set Printer dialog box, click Connect.

Figure 5-85
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3. Enter the computer name or its IP address, or click Browse to find and
select it.

Figure 5-86 Connecting to a printer (B)
4. Click OK.
When the connection is established, Objet Studio is configured to prepare
print jobs for that printer.
If you can see the material levels in the "Job Manager Screen" (see Figure
5-84 on page 5-65), Objet Studio is connected to the printer.
Normally, there should be no reason to change the printer connection.
Occasionally, however, you may need to reset the connection, to connect the
server to another printer, or to use Objet Studio in off-line mode (without a
printer connection).
Note: A printer can be listed by its name or by its computer's IP address.

Off-line Mode
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You can use Objet Studio to prepare trays for printing in off-line mode, on a
remote computer or when the printer connection is not available. You also
use off-line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off-line mode by removing this connection.
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To disconnect Objet Studio from the printer:
1. On the Job Manager ribbon, in the 3D Printer group, click

.

2. In the Set Printer dialog box, click Connect (see Figure 5-85 on page 567).

Figure 5-87 Disconnecting Objet Studio from a printer (A)
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3. In the Printer Connection dialog box, delete the computer name/IP
address.

Figure 5-88 Disconnecting Objet Studio from a printer (B)
4. Click OK.
“Unknown” appears in the printer-name field.
5. Click OK.
6. In the pop-up message, confirm that you want to work in off-line mode by
clicking No.

Figure 5-89 Off-line message
When Objet Studio is in off-line mode, you can configure it for preparing
print jobs for different printers.
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To change the Objet Studio off-line configuration:
1. In the Set Printer dialog box, select a printer type.

Figure 5-90 Off-line printer selection
2. Click OK (not “Connect”).
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Setting the
Remote Printer
Connection
(Client Mode)

When you open Objet Studio for the first time in a client installation, you are
prompted to connect to a server computer that sends jobs to a 3D printer. To
do this, the server computer must be operating and connected to the local
network.
To set (or change) the connection to the server-computer:
1. On the Job Manager ribbon, in the 3D Printer group, click

.

2. Enter the name of the server computer or its IP address, or click Browse
to find and select it.
3. Click OK.

Figure 5-91 Printer Server Connection dialog box

Job Manager
Commands

The Job Manager ribbon has three icon groups:
❒ 3D Printer
❒ Queue
❒ Job

Figure 5-92 Job Manager ribbon commands
Icons are enabled or disabled according to their relevancy. For example, since
you cannot stop printing a job that is not being printed, the Stop command is
disabled when the printer is idle.
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The following operations are available on the Job Manager ribbon:
Group Icon

Purpose

3D
Printer

Client: Sets the server connection. See "Setting the Remote Printer Connection (Client Mode)" on the previous page.
Server: Sets the printer connection. See "Setting the Printer Connection"
on page 5-67.
Configures options for printer alerts. See "Configuring User Alerts" on
page 5-75.

Queue

Server: Moves a job to the head of the Jobs Queue.
Client: Disabled.
See "Jobs Queue" on page 5-66.
Server: Moves a job to a higher position in the Jobs Queue.
Client: Disabled.
See "Jobs Queue" on page 5-66
Server: Moves a job to the bottom of the Jobs Queue.
Client: Disabled.
See "Jobs Queue" on page 5-66.
Server: Moves a job to a lower position in the Jobs Queue.
Client: Disabled.
See "Jobs Queue" on page 5-66.

Job

Server:
• For a job in the Jobs Queue—Prints it again (from the beginning).
• For a job in the History list—Moves it to the Jobs Queue for printing.
Client: Disabled.
See "Restarting Jobs" on page 5-79.
Server: Stops a job in progress.
Client: Disabled
Server: Continues printing the current job from the point where printing
stopped.
Client: Disabled.
See "Resuming Jobs" on page 5-79.
Removes the selected job from the queue.

Refreshes the image of the selected job in the Tray Preview display.

Opens the Tray Settings screen and displays the tray. For deleted jobs,
this enables you to make changes before printing.
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In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Figure 5-93 Icons on pop-up toolbar (server)

Figure 5-94 Icons on pop-up toolbar (client workstation)
Note: Most icons and menu commands are only enabled when a job is
selected.
When you position the cursor over an item, a tooltip displays the name of
the command.

Figure 5-95 Job menu options (server)
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Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:
• The level of model or support material is low.
• The job was interrupted.
• The job was completed successfully.
To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.
Only the subject line of the e-mail message is transmitted by SMS.
To configure Objet Studio to send notifications and alerts:

1. On the Job Manager ribbon, in the 3D Printer group, click

.

Figure 5-96 Notifications dialog box (server)
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Figure 5-97 Notifications dialog box (client workstation)
2. Set the desired reporting options.
3. Click Details.

Figure 5-98 Event selection for alerts
4. In the Reports Events dialog box, select the alert events and click OK.
5. In the Notifications dialog box, click OK.

Printing from
the Jobs
Queue
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If there is a job in the Jobs Queue, it is sent automatically to the Stratasys
PolyJet printer—as long as it is on, there is a connection to the printer, and
the printer is on line.
Chapter 6 describes starting and operating the printer.
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Objet Studio on the printer server includes the following additional features:
• "Extended Tray Preview"
• "Editing Jobs"
• "Restarting Jobs"
• "Resuming Jobs"
• "Scheduling Jobs"
• "Exporting Jobs (objzf)"
• "Modifying the Job Manager Screen"
These features are described on the following pages.

Extended Tray Preview
In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.
To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
2. Click the Tray Preview pane.

Figure 5-99 Job Preview
❒ To change the tray magnification, turn the mouse wheel.
❒ To view the tray from a different perspective, click the relevant icon.
❒ To resize the window, drag its edge or corners.
If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.
To prevent the printing of an object on the build tray:
1. Double-click on the object you do not want to print.
2. Display the Build tab.
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3. Select Exclude from Build.

Figure 5-100 Excluding a model from the build
4. Click Yes to confirm.
On server computers, you can use Tray Preview to dynamically display objects
as they are printed, layer by layer. This enables you to visually monitor
printing progress on the computer screen.
To display printing progress in the Tray Preview pane:
➢ From the Job menu, select Show 3dProgress.
This option uses additional system resources.

Editing Jobs
You can open jobs in the Jobs Queue for editing.
To edit a job:
1. Select the job.
2. Click the Edit icon
.
The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”
3. Edit the job.
4. On the Tray Settings ribbon, click
.
The status of the job in the Job Manager screen changes back to
“Waiting.”
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Restarting Jobs
You can restart jobs from the Jobs Queue and the History list.
To restart a job:
1. Select the job.
2. Click the Restart icon
.
The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs If the printing process is stopped or interrupted, you may be able to continue
printing the job from the point where printing stopped.
When resuming a print job, the printer tray does not move. The printer
expects Objet Studio to send the slice from where the stoppage or failure
occurred.
To resume a job:
1. Select the job.
2. Click

.

Scheduling Jobs
You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and early
morning hours.
To schedule a job:
1. Select a job in the Jobs Queue, and click

on the pop-up toolbar.

2. In the Scheduler dialog box, set the Start Date and Start Time for the job.
Click on the Start Date arrow to open a calendar.

Figure 5-101 Scheduler with calendar displayed
3. Click OK.
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Exporting Jobs (objzf)
You can save print jobs as compressed files.
For an explanation of objzf files, see "Saving and Importing Build Trays"
on page 5-49.
To export a print job:
1. Select a job.
2. On the pop-up toolbar, click

.

3. In the Save As dialog box, select a folder.
4. Click Save.

Modifying the Job Manager Screen
You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:
• the Jobs Queue panel
• the Time panel
• the History panel
Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.
You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.
• Click again to display the panel.
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Operating and Maintaining the
Objet30 3D Printer
Starting the Printer
Loading Model and Support Cartridges
Producing Models
Preparing the Printer
Printer Interface Color Key
Printing Indicators

Resuming Production After Printing has Stopped
Changing the Printing Material
Keeping the Printer in Idle Mode
Shutting Down the Printer

6-3
6-5
6-7
6-7
6-10
6-11

6-12
6-14
6-20
6-21

Shutdown Wizard
Material Flush/Fill Wizard

6-22
6-24

Maintaining the Printer

6-27

Routine Maintenance Schedule
Cleaning the Print Heads and the Roller
Cleaning and Replacing the Wiper
Pattern Test
Improving Print Quality
Cleaning and Replacing the Roller Waste Collector
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Figure 6-1 The Objet30 3D Printer

Starting the Printer
Caution
l

l

Do not attempt to operate the printer before being trained by a Stratasys
Customer Support representative.
Observe all safety warnings and follow the safety guidelines described in
Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2 Main power switch and cable
The main power switch turns on the Objet30 printer, which includes —
the built-in computer.

DOC-34022 Rev. D

6-3

Objet30 User Guide

6 Operating and Maintaining the Objet30 3D Printer

2. After the computer boots, open the Remote Desktop Connection on the
server (“host”) computer, by double-clicking the Printer computer
shortcut.
A HASP plug containing a valid product activation key is required on the
printer computer. This is installed at the factory or during printer upgrade.
If the application does not open and a HASP message appears, contact
your dealer or Stratasys Customer Support.
The Objet printer interface screen opens. All monitoring and controlling of
the printer is done from this interface.

Figure 6-3 Objet30 interface
The time zone on the printer computer is factory-set and it cannot be
changed. Similarly, the computer’s clock cannot be configured to
automatically change the time for different seasons of the year. If
necessary, you can change the displayed time manually, but do so only
when the printer is idle.
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Loading Model and Support Cartridges
Objet30 printers use two cartridges of Model material and two cartridges of
Support material, each weighing one kilogram when full. A graphical
representation of the cartridges loaded and their current weight appears in
the printer interface (see Figure 6-3 on the previous page).
Note: The printer-control interface displays the type and weight of the material
cartridges loaded only if the materials drawer is closed.
The printer uses RFID technology to automatically identify cartridges of
printing material. For this purpose, an RFID module is part of the printer
hardware. Tampering with this module will render the printer inoperable
and may void Stratasys warranties and service contracts.
Important: If you need to replace the Model material currently installed with
another type, see "Changing the Printing Material" on page 6-14. Otherwise,
make sure to replace the Model cartridge with one containing the same type of
material.
To load Model and Support material:
1. On the front of the printer (see Figure 3-1 on page 3-2), push the materials
drawer to release it and pull it open.
2. If you are replacing a cartridge, remove the old one by pulling it straight
up.
3. Load Model and Support cartridges into their respective compartments
(see Figure 6-4).

Figure 6-4 Materials drawer
4. Close the materials drawer.
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5. Check the printer interface to make sure that the new cartridge is detected
and that its weight is displayed (see Figure 6-3 on page 6-4).
Tips about loading and replacing material cartridges:
l

It recommended that you always have two material cartridges loaded in the
printer. When the weight of the material in one cartridge drops below 100
grams, the printer pumps material from both cartridges until one is empty. If
only one cartridge is used, printing stops when the weight of the material
drops below 100 grams. (Similarly, printing stops if the weight in both
cartridges is below this level.)

Note: Objet Studio does not display the weight of material in a cartridge if it
is under 100 grams.
l

l

l

l

DOC-34022 Rev. D

You can replace material cartridges either before or during printing. If you do
so while printing, make sure to load the new cartridge and close the materials
drawer within three minutes. This ensures that the print job is not interrupted.
(When the drawer is open, the cartridges are not displayed in the printer
interface.)
If printing stops for an extended time before you replace a material cartridge,
the printer may go into Standby or Idle mode. If this happens, see "Resuming
Production After Printing has Stopped" on page 6-12.
You can replace partially used cartridge to avoid the need for replacing them
during printing. However, repeated removal and installation of a cartridge may
cause the material in it to leak. Therefore, it is recommended that you limit the
re-installation of used cartridges.
The cartridge type is automatically detected by the printer. If you replace a
cartridge containing different Model material, a message appears
recommending that you run the Material Replacement wizard to flush out the
old material.
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Producing Models
The Objet30 printer produces models after they are arranged on a virtual
build tray in the Objet Studio application and sent to the printer from there.
For information about preparing model files for printing, see "Using Objet
Studio" in this user guide or Objet Studio Help.
The Objet30 printer is capable of printing models with the following
maximum dimensions:
➢ With glossy finish—
X-axis: 294.00 mm (11.57 inches)
Y-axis: 192.00 mm (7.55 inches)
Z-axis: 148.60 mm (5.85 inches)*
* OrthoDesk printers—100.0 mm (3.94 inches)
➢ With matte finish—
X-axis: 293.00 mm (11.53 inches)
Y-axis: 191.00 mm (7.52 inches)
Z-axis: 148.30 mm (5.83 inches)*
* OrthoDesk printers—97.9 mm (3.85 inches)

Preparing the
Printer
Before beginning to produce models, it is recommended that you check
the current printing quality of the print heads by performing a pattern test
(see "Pattern Test" on page 6-33).

To prepare the printer for producing models:
1. Make sure that the build tray in the printer is empty and clean. If not,
remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

Caution
Use protective gloves when cleaning the build tray, and be careful of the
sharp edges of the scraper blade.
2. Make sure that there is sufficient Model and Support material loaded, as
indicated on the printer interface (see Figure 6-3 on page 6-4). You may
want to replace the cartridges of Model and Support material currently
loaded in the printer to avoid the need for replacing them during printing.
For installing material cartridges and replacing empty ones, see "Loading
Model and Support Cartridges" on page 6-5.
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3. On the printer interface, click the red button to switch the printer to
online mode.
The color of the button changes from red to green (see Figure 6-7 on the
next page). If there is a job in the Job Manager queue, it is sent to the
printer.
When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality. (See
"Routine Maintenance Schedule" on page 6-27.) Maintenance notifications
can be disabled/enabled from the Options menu.
On the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:
• The print block is heated.
• If more than 48 hours have passed since the last print job, the printing
materials in the print heads are flushed and replaced, to ensure quality
printing. (This step adds 7 to 14 minutes to the Pre-print cycle, and it is
displayed on the printer interface.)

Figure 6-5 ReInitiate process during the Pre-Print cycle
• The UV lamp is powered and it warms up.
When printing begins, Objet Studio sends seven slices to the printer-control
application. This is the standard buffer between Objet Studio and the printer.
As each slice is printed, another slice is sent to the printer.
Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model and
Support material in the supply cartridges, printing proceeds automatically
until the job is finished.
During printing, the server computer must remain on and it must
communicate with the Objet30 printer. Do not log-off Windows until
printing is finished.
The Objet30 printer uses one Model-material cartridge and one Supportmaterial cartridge to produce models. When four cartridges are loaded in the
printer, two of them are reserve, or standby, cartridges. By default, the printer
first uses the cartridges with the least material in them.
➢ The active cartridges are blue on the printer interface.
When the weight of a cartridge drops below 200 grams, the remaining
material displayed on the printer interface is red.
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When the weight of a cartridge drops below 100 grams, the printer alternates
the pumping of material between the heavier and the almost-empty cartridge.
This is indicated on the printer interface by an hour-glass icon. (See Figure 68 on page 6-11.)
When a cartridge is completely empty, a trash icon is displayed.

Figure 6-6 Empty cartridge indicator
You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button on the printer interface
screen.

Figure 6-7 Printer indicators
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.
• Green—suitable/ready for printing
For example, in Figure 6-7 on the previous page:
❒ Ambient—The ambient temperature of the printing chamber is within
the acceptable range.
❒ Heads Liquid—The level of Model and Support material in the
print-block reservoir is OK.
❒ Vacuum—The vacuum level in the system is within the acceptable
range.
• Red—not suitable for printing (or indicates a warning)
For example, in Figure 6-7 on the previous page:
❒ Waste—The weight of the waste container is 1520 grams, more than
allowed when beginning a print job. ("Replacing the Waste Container"
on page 6-96.)
• Blue—not ready
For example, in Figure 6-7 on the previous page:
❒ UV lamp—The UV lamp is not on.
❒ Heads (°C)—The heads have not reached the temperature required for
printing models (in printing mode).
The color of the material cartridges displayed in the printer interface indicates
which cartridges are active for the current (or next) print job.
• Blue—active cartridges
• Gray—reserve cartridges
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The printer interface screen changes when you send a print job to the printer
(from Objet Studio), if the printer is on line:
• The mode changes from Pre-print to Printing.
• The specific activity being performed is shown in the “current activity”
field.
• Current job-printing information is displayed.
• The printing progress bar is displayed.
• The Stop button is enabled.

Figure 6-8

Printer interface during printing

During printer operation, the following window may occasionally appear.

Figure 6-9 Q-Monitor
This window records information for service personnel only, and it does not
require your attention. You can close or minimize it to remove it from view.
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Resuming Production After Printing has Stopped
If the printing process is interrupted, Job Manager stops sending slices to the
printer. This can happen, for example, if the printing material runs out in the
middle of a print job, and you do not replace the empty cartridge immediately.
After the printer changes to Standby or Idle mode, you need to resume
printing from the Job Manager screen of Objet Studio.
After printing stops, the printer goes into Standby mode, when heating of
the print heads is reduced. About 20 minutes later, the printer goes into
Idle mode, when heating of the print heads is stopped.

To continue printing the model:
1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see Figure 6-3 on page
6-4).
The button changes from red to green (see Figure 6-3 on page 6-4).
2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.
3. In the Job Manager screen of Objet Studio, click the Resume icon

.

4. In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.

Figure 6-10 Printer interface after interrupted printing

Figure 6-11 Continue from Slice confirmation in Objet Studio (Job
Manager screen)
5. If, for any reason, the correct number does not appear in the dialog box,
enter the number and click OK.
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You cannot continue printing the model if:
• The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.
• There was a relatively long interruption in printing, even if the “last slice”
and “continue from slice” indicators are correct. The part of the model
already printed may deform or shrink, and there might be a visible
difference between it and the newly printed part. The effects of a printing
stoppage on a model depend on the model size and structure, Model
material used, ambient temperature and the length of the stoppage.
If you cannot continue printing:
1. Cancel the print job in the Job Manager screen.
2. Remove the partially printed model from the build tray.
3. Restart the job from the Job Manager screen (in Objet Studio).
You can stop printing from either the printer interface or from the Job
Manager screen of Objet Studio. Resuming printing is only available from
the Job Manager screen.
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Changing the Printing Material
When you want to produce models with a different type of printing material
than is currently installed, you need to run the Material Replacement wizard
to flush the print block and feed tubes. However, if the type of material used
for printing the new models is unimportant, you can replace the material
cartridge without first flushing out the old material.
You should carefully plan printing models with different Model materials to
avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are
replacing one or both Model cartridges. For details, see Flushing Options.

To replace the printing material with the wizard:
1. Start the Material Replacement wizard from the Options menu.

Figure 6-12 Starting the Material Replacement wizard
2. In the opening screen, click Next.
3. If the printer cover is not closed, a screen appears, prompting you to close
the cover. Confirm that it is closed and click Next.
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4. When the Cartridge Loading screen appears, indicate whether or not
replacement cartridges have been loaded.

Figure 6-13 Replacement-cartridge status
5. Click Next.
❒ If the replacement cartridges are already loaded in the materials
drawer, a screen appears, showing the materials currently in the
system and the material cartridges in the drawer.

Figure 6-14 Material Replacement Summary screen
After reviewing this screen, click Next and continue with step 8.
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❒ If the replacement cartridges are not loaded in the materials drawer,
the Compartment Selection screen appears.

Figure 6-15 Compartment Selection screen
6. Select the cartridge(s) you want to replace, and click Next.
7. From the drop-down menu, choose the material you want to install, and
click Next.

Figure 6-16 Material Selection screen
The Model materials available for selection depend on your printer type
and license.
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8. In the Flushing Options screen, choose the appropriate cycle for the
Model material you want to install.

Figure 6-17 Flushing Options screen
❒ Economy. During this cycle, which takes about 25 minutes, the pump
purges the Model material from the print block, then flushes the
system with the new material.
Since traces of the previous material may be present in the first models
printed with the new material, this cycle is usually acceptable when
replacing a light-colored Model material with a darker material (such
as TangoBlack™ or VeroBlack™), or if the exact color of the printed
models is unimportant. In most cases, models will have the
mechanical properties of the new material (except when switching
between Vero and Tango materials).
The amount of material flushed during this cycle is—
¤ 65 grams (± 10%) when replacing one cartridge
¤ 110 grams (± 10%) when replacing two cartridges
❒ High-performance. During this cycle, which takes about 60 minutes,
the wizard cleans the feed tubes and print block more thoroughly,
compared to the Economy cycle, by flushing the system with more
material.
This cycle ensures that models will have both color and mechanical
properties of the new material. This is important when replacing a
dark-colored material (such as VeroBlack or TangoBlack) with a
lighter-colored material, and when switching between Vero and Tango
materials.
The amount of material flushed during this cycle is—
¤ 300 grams (± 10%) when replacing one cartridge
¤ 450 grams (± 10%) when replacing two cartridges
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9. Click Next, and take note of the warning.

Figure 6-18 Material Replacement warning screen
Once you start this procedure, you must complete it before you can
produce models with the Objet printer. To perform the procedure at
another time, click Cancel. If you continue (by clicking Next) and you do
not complete the procedure, you must start the Material Replacement
wizard again before producing models.
10. Click Next.
❒ If the replacement cartridges are already loaded in the materials
drawer, the wizard checks that there is sufficient material to complete
the procedure. Continue with step 7.
❒ If the replacement cartridges are not loaded in the materials drawer,
the wizard prompts you to remove the cartridge(s) from the drawer.
Continue with step 11.
11. When prompted by the wizard screen, remove the material cartridge(s).
Confirm this in the wizard screen and click Next.

Figure 6-19 Remove Cartridge confirmation screen
12. When prompted, load the new cartridge(s) and close the drawer. Confirm
this in the wizard screen and click Next.
The wizard identifies the cartridge(s) and verifies that there is sufficient
material to complete the procedure.
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13. After checking the amount of material in the cartridges, the wizard
proceeds as follows:
❒ If the amount of material is insufficient for completing the procedure,
the wizard prompts you to replace the cartridge(s).

Figure 6-20 Prompt to replace cartridge due to insufficient material
Replace the required cartridge(s). Confirm this in the wizard screen and
click Next.
❒ If the amount of material is sufficient for completing the procedure,
the printer purges the current material from the system, then flushes
the system and fills the print heads with the new material.

Figure 6-21 Material replacement: filling heads with new material
14. Click Done to close the wizard.
The printer-control application is automatically updated, and the interface
displays the new material(s). Objet Studio (on the server computer) is also
updated and displays the new material(s).
15. Inspect the area around the purge unit and clean it, if necessary.

Caution
Dispose of all material cartridges in accordance with all applicable laws
and regulations. If necessary, the cartridges can be disassembled for
recycling. If this is done, protect the person handling the cartridges from
direct exposure to uncured resins.
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Keeping the Printer in Idle Mode
Between printing jobs, the Objet30 printer can be left unused for up to one
week. If the printer will not be used for more than a week, use the Shutdown
wizard to automatically perform the procedures that must be done before
turning off the printer (see "Shutting Down the Printer" on the next page,
below).
When the printer stops producing models, the printer software automatically
reduces the temperature of the print heads as follows:
After printing stops

Mode

Change in heating of print heads

first 15 minutes

Standby 1

no change

next 5 minutes

Standby 2

heating reduced (to room temp.)

after Standby 2

Idle

heating stopped

Note: The printer mode is indicated in the green field on the left of the interface
(see Figure 6-3, and Figure 6-8 on pages 6-4, and 6-11).
If, after printing a job, you know that the printer will not be used for 20
minutes or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.
To put the printer into Idle mode:
➢ From the File menu (in the printer interface) click Exit.
Note: The printer remains in Idle mode until you open the Objet30 printer
application and begin printing again.
When the printer is in Idle mode, do not turn it off. It can remain in this
mode—with the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown wizard (see below).
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Shutting Down the Printer
You only need to shut down the Objet30 printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode.
The Shutdown process flushes printing materials from printer
components. To avoid flushing out valuable material, make sure to print
models at least once a week. Many printer operators use this opportunity
to print customer samples or test models.
To properly shut down, the printer needs to perform several processes. Do
not attempt to shut down the printer by simply closing the
computer interface (the printer-control application), and never
disconnect power to the printer before completing the Shutdown
wizard.

Caution
Not using the printer for an extended period without first running the
wizard can cause serious damage to print heads and other expensive
printer parts.
• Shutdown for Less Than One Week
Before shutting down the printer or the printer computer for less than
one week, run the "Shutdown Wizard". This wizard clears the print heads
of printing materials before shutdown.
• Shutdown for One Week or More
Before shutting down the printer or the printer computer for one week or
more, first run the "Material Flush/Fill Wizard". This wizard replaces
printing materials in the print block with cleaning fluid.

Note: After preparing the printer with the Material Flush/Fill wizard, you
must run it again before printing models, this time to replace the cleaning fluid
in the print block with printing materials.)
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To run the Shutdown wizard:
1. Select Shutdown wizard from the Options menu, or press F8.

Figure 6-22 Shutdown wizard, opening screen
2. Select Run wizard unattended, unless you want more control over the
shutdown process.
Note: If you select Run wizard unattended, the wizard automatically turns off
the printer computer at the end of the process.
3. Click Next.
The options in the following screens are enabled only if you selected Run
wizard manually in the opening wizard screen.
4. In the next screen, indicate whether or not the tray is empty and click
Next.

Figure 6-23 Tray status screen
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The shutdown procedure begins.

Figure 6-24 Shutdown progress screen
The shutdown procedure may take up to 10 minutes while the following
tasks are performed:
a. The print block returns to its starting point on all axes.
b. The print heads are heated.
c. The print heads are cleared of any remaining material.
After these tasks are completed, the final wizard screen appears, in which
you choose whether or not to shut down the computer in the Objet
printer at this time.

Figure 6-25 Computer Shutdown confirmation screen
5. When completely shutting down the Objet printer and turning the power
off, select Yes and click Next.
6. After the printer computer shuts down, turn off the main power switch at
the back of the printer (see Figure 6-2 on page 6-3).
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Using the Material Flush/Fill wizard before and after an extended period of
inactivity (more than one week) ensures proper printer maintenance and
quality printing. Each time you run the wizard, you select one of the following
processes:
• draining printing materials and flushing the system with cleaning fluid
Use this process to prepare the printer for a shutdown of more than one
week. This process takes about 60 minutes, and requires four (4) cleaningfluid cartridges in the materials drawer.
• filling the system with fresh printing materials
Use this process to restore the printer to working condition. This process
takes about 30 minutes, and requires two (2) cartridges of Model material
and two (2) cartridges of Support material in the materials drawer.
After more than one week of inactivity, drain and flush the system if this
was not previously done. In this case, run the wizard twice before
printing—first, to drain old printing material and clean the system, and
again, to fill it with fresh material.

To run the Material Flush/Fill wizard:
1. Start Material Flush/Fill wizard from the Options menu.
2. In the opening screen, click Next.

Figure 6-26 Wizard procedure selection
3. Select the required procedure, and click Next.
Note: Before continuing, make sure the required cartridges of material are
available for the procedure selected.
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4. Load the required cartridges, close the drawer, and confirm this in the
wizard screen.

Figure 6-27 Cartridge confirmation screen—before flushing

Figure 6-28 Cartridge confirmation screen—before filling
5. In the next wizard screen, confirm that the printer cover is closed, and
click Next.
The wizard runs the material-flushing cycles.

Figure 6-29 Flushing cycles in progress
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6. If cleaning-fluid cartridges are loaded in the printer, the wizard prompts
you to remove them. Confirm this in the wizard screen, and click Next.

Figure 6-30 Final wizard screen
After preparing the printer for an extended shutdown period with this
wizard, you should close the printer-control application and Windows, and
then turn off the printer.
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Maintaining the Printer
Performing routine maintenance tasks is essential for getting satisfactory
results from Objet30 3D printers. Perform the tasks at specified intervals.
When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality.
Maintenance notifications can be disabled/enabled from the Options
menu.

Routine
Maintenance
Schedule

DOC-34022 Rev. D

Frequency

Task

After every print job

Clean the print heads and
the roller surface.

See "Cleaning the Print
Heads and the Roller" on
the next page.

Weekly

Perform the Pattern test.

See "Pattern Test" on
page 6-33.

Weekly

Clean and inspect the
wiper.

See "Cleaning and
Replacing the Wiper" on
page 6-31.

Weekly—when printing with
MED610

Calibrate the UV intensity.

See "Testing and
Calibrating the UV Lamp"
on page 6-63.

Weekly

Restart the printer
computer and the
server computer.

Every 300 hours of printing (A
reminder message appears.)

Calibrate the UV intensity.

See "Testing and
Calibrating the UV Lamp"
on page 6-63.

Every 300 hours of printing

Optimize the print heads.

See "Optimizing
(Calibrating) Print Heads"
on page 6-43.

Monthly, and after replacing
print heads

Check the alignment of
the print heads.

See "Aligning the Print
Heads" on page 6-39.

Every 500 hours of printing, or
once every six months

Calibrate the load cells.

See "Calibrating the Load
Cells" on page 6-66.

For More Information

Every 1000 hours of printing, or Preventive maintenance.
once a year

See "Preventive
Maintenance Tasks" on
page 6-99.

Once a year

Inspect the activatedcarbon odor filter, and
replace if necessary.

See "Replacing the Odor
Filter" on page 6-68.

Once in two years

Calibrate the UV sensor

Performed by a Stratasys
Service Engineer.
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Periodic inspection and cleaning of the orifice plates on the bottom of the
print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to enable
you to perform it. To maintain the Objet30 printer in optimum condition,
clean the print heads after every print job, when you remove the model from
the build tray. This procedure takes about 20 minutes.
To clean the print heads and the roller:
1. Prepare—
❒
❒
❒
❒

isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
disposable cleaning gloves
a supplied cleaning cloth or equivalent
a mirror

2. Start the Head Cleaning wizard from the Options menu (see Figure 6-35
on page 6-31).
3. Follow the instructions on the wizard screens, and select the confirmation
check boxes.

Figure 6-31 Head cleaning procedure—wizard screen
4. Click Next.
The printer prepares for you to clean the print heads.
5. When the following screen appears, open the cover.

Figure 6-32 Head cleaning wizard—steps 5–11
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Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch
them with your bare hands, and proceed with caution.
6. Place the mirror on the build tray.
7. Put on the gloves.

Caution
Uncured printing material on the print heads might cause skin irritation.
Use disposable cleaning gloves to protect your hands.
8. Soak the cleaning cloth with alcohol.
9. Clean the orifice plates, with a back-and-forth motion (see Figure 6-33).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-33

Cleaning the heads

10. Clean the entire roller surface, by rotating it as you clean.
Use this opportunity to clean the glass lens on the UV lamp.
11. When you have finished cleaning, select the confirmation check boxes in
the wizard screen (see Figure 6-32) and click Next.
12. Remove the cleaning materials from the printer and close the cover.
13. Select the confirmation check boxes in the wizard screen and click Next.
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The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Figure 6-34 Head-cleaning wizard—final screen
14. Click Done to close the wizard.
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A rubber wiper removes excess material from the print heads after the purge
sequence. This is done automatically before each print job, and performed
manually during maintenance tasks. You should clean the wiper and
surrounding area daily. If the wiper is damaged or worn, replace it.
To inspect and clean the wiper:
1. Prepare—
❒
❒
❒
❒

isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
disposable cleaning gloves
a supplied cleaning cloth or equivalent
a spare wiper

❒ an M2.5 hex (Allen®) key
2. Start the Wiper Cleaning wizard from the Options menu.

Figure 6-35 Starting the Wiper Cleaning wizard
3. In the opening wizard screen, click Next.
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4. Make sure that the build tray is empty, and close the printer cover.
Confirm this in the wizard screen and click Next.

Figure 6-36 Wiper Cleaning —step 4
5. When the following screen appears, open the cover.

Figure 6-37

Wiper Cleaning wizard during steps 6–9

6. Put on the cleaning gloves.
7. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.
8. Inspect the wiper.
If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.
a. With the M3 hex (Allen) key, loosen (but do not remove) the screw
securing the wiper.

Figure 6-38 Wiper and excess-material drain
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b. Grasp the wiper unit and remove it.
Note: Do not remove the grease.
c. Insert the new wiper, making sure that it is level, and tighten the
securing screw.
9. In the wizard screen (see Figure 6-37), confirm that the wiper blade is
clean, and click Next.
10. Remove all tools and cleaning materials from the printer, and close the
cover.
11. Confirm this in the wizard screen, and click Next.

Figure 6-39 Confirmation screen
12. Click Done to close the wizard.

Pattern Test

The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the print
heads. Make sure, therefore, that you perform this test weekly, and whenever
you suspect a printing problem.
To perform the pattern test:
1. Make sure that the build tray is empty.
2. Prepare a sheet of pink paper, approximately 21 × 14 centimeters in size
(8.5 × 5.5 inches)—half of the standard A-4 or Letter size.
3. In the printer, tape the pink paper to the center of the build tray.
4. Press F3, or open the Options menu and select Pattern Test.

Figure 6-40 Pattern Test confirmation
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5. In the following dialog box, click OK to confirm that the paper is in place
on the build tray.

Figure 6-41 Confirmation before printing on test paper
The printer prints a series of lines on the test paper (see next figure).

Figure 6-42 Sample Pattern Test
6. Carefully inspect the test paper to see if there are missing lines.
Too many missing lines, especially if they are in the same area, indicates
that the quality of printing when producing models will be poor. If this is
the case, see "Improving Print Quality" on the next page.
Note: Acceptable model quality is subjective, and depends on the type and
scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable. As a rule,
however, if two consecutive lines are missing, or if there are more than 10
lines missing in either column, the model quality is usually unacceptable.
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If you suspect that print quality is poor, perform the pattern test (see "Pattern
Test"). If the results are poor, use the following procedure to improve print
quality.
If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.
2. In the confirmation dialog box, click Yes.
The print heads are purged of Model and Support material, and the wiper
removes excess material from them.
3. Repeat the purge sequence.
4. Perform the pattern test.
If the results of the pattern test are still poor:
1. Manually clean the print heads (see "Cleaning the Print Heads and the
Roller" on page 6-28).
2. Perform the purge sequence.
3. Perform the pattern test.
If the results of the pattern test are still poor:
1. Carefully clean the print heads again, making sure there is no residue left
on them.
2. Perform the purge sequence.
3. Perform the pattern test.
If the results of the pattern test are still poor:
➢ Optimize the print heads and replace faulty print heads, if necessary (see
Optimizing (Calibrating) Print Heads).
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Normally, you do not have to inspect and clean the roller waste collector. This
is done by a customer-support engineer during regular maintenance visits.
Occasionally, however, a blockage or damaged scraper may cause material
leakage on the build tray. If this happens, remove the roller waste collector to
inspect it.
To remove the roller waste collector:
1. Start the Head Cleaning wizard from the Options menu (see on page 631).
This wizard prepares the printer for removing the roller waste collector.
2. When the following screen appears, confirm that the tray is empty and
that the printer cover is closed, then click Next.

Figure 6-43 Wizard confirmation screen
The print block moves to the center of build tray, and the tray lowers.
3. When the following screen appears, open the cover.

Figure 6-44 Wizard screen that appears when you can begin the
procedure

Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch
them with your bare hands, and proceed with caution.
4. Put on protective gloves.
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5. Loosen the two side screws securing the UV lamp assembly, and place the
assembly on top of the print block.

Figure 6-45 UV-lamp-assembly securing screws
6. Pull out the drain-tube release mechanism to raise the tubes out of the
waste collector (see figure below).

Figure 6-46 Freeing the drain tubes from the waste collector
Important: Pull out the release mechanism completely.
7. Support the roller waste collector with your hand under it, and use a
3 mm hex (Allen) key to loosen the screws.

Figure 6-47 Roller-waste-collector screws
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8. Pull out the roller waste collector, taking care not to touch or damage the
scraper.

Warning
The scraper is very sharp! Proceed with caution.

Figure 6-48 Roller waste collector
9. Inspect the roller waste collector.
❒ If the scraper is damaged, replace the entire roller-waste-collector unit.
❒ If the scraper is not damaged, carefully remove any waste from the
waste channel, taking care not to damage the scraper. If necessary, use
IPA or ethanol to dissolve residue material in the waste channel and
on the scraper.
Note: The waste collected in this unit contains uncured resin. Dispose of it in
accordance with applicable environmental regulations.
To install the roller waste collector:
1. Carefully insert the roller-waste-collector unit.
2. Secure the unit evenly, by alternately tightening the screws.
3. Return the drain-tube release mechanism to its original position by
pushing it in all the way.

Figure 6-49 Returning the drain tubes from to the waste collector
4. Move the print block back to the middle of the printer.
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5. Replace the UV lamp assembly in the printer, making sure that the cable
fits into the slot together with the side securing screw.

Figure 6-50 UV-lamp cable in place after securing the assembly
6. Remove all tools from the printer, and close the cover.
7. In the wizard screen, click Cancel to return the build tray to its former
position.

Aligning the
Print Heads

You should check the alignment of the print heads—
• once a month
• after replacing one or more heads
• if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see "Cleaning the Print Heads and the
Roller" on page 6-28).
This procedure takes about 20 minutes.
To check the alignment of the print heads:
1. Prepare—
❒ a transparency sheet, at least 10.5 × 13 centimeters in size (4.5 × 5.5
inches)—about one-quarter of the standard A-4 or Letter size
❒ any type of adhesive tape, to fasten the transparency sheet to the build
tray
2. Start the Head Alignment wizard from the Options menu.
3. Click Next to begin, and close the cover.
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4. In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

Figure 6-51 Door is closed confirmation screen
5. When instructed to do so, place the transparency on the build tray— near
the left and rear edges of the tray, as shown in the following figure.

Figure 6-52 Positioning the transparency on the build tray
6. Make sure that the transparency sheet is lying flat, and tape it to the tray.
7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.
The printer prints the head alignment test on the transparency.
8. When the following screen appears, remove the transparency.

Figure 6-53 Head Alignment wizard—steps 8–10
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The transparency sheet is printed with sets of vertical lines in two rows,
each showing the results from a different print head.

Figure 6-54 Sample head-alignment test
❒ The top row was printed by the head used for applying Model material
when producing models. From right to left, the columns represent
heads M1, M2, M3, respectively. (There is no column for head M0
because its alignment is used as a reference for aligning all other
heads.)
❒ The bottom row was printed by the head used for applying Support
material.
9. Use a magnifying glass or loupe to inspect the transparency.
Optimum head alignment is shown when the two #8 lines, in the upper
and lower rows, are aligned, as in Figure 6-54. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment—in the next wizard screen.
10. In the wizard screen shown in Figure 6-53, select the Transparency
removed check box, and click Next.
The first in a series of alignment screens appears.

Figure 6-55 Head alignment screen
11. In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows.
Note: Because the alignment of the middle lines is optimum, the number “8”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.
12. Click Next.
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The following screen is displayed.

Figure 6-56 Parameter update confirmation
13. Continue as follows:
❒ To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.
❒ To recheck the alignment test results before making the alignment
changes in the printer, click Previous.
❒ If you do not want to make alignment changes in the printer at this
time, select No and click Next.
14. In the following screen, you can choose to either repeat the head
alignment procedure or close the wizard.
❒ If the most closely aligned vertical lines for a print head were at either
extreme, choose Repeat the test, then click Next.
The transparency test will show if the heads are now properly aligned,
and—if not—the wizard will allow you to “fine tune” the alignment.
❒ If the vertical lines for the print heads were not aligned at either
extreme, choose End the wizard, then click Next.

Figure 6-57 Repeat head alignment option
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If the Head Alignment wizard was opened from the Head Optimization
wizard after replacing print heads, the printer application closes and reopens when you click Done in the final wizard screen.

Optimizing
(Calibrating)
Print Heads

The condition of the print heads directly affects the quality of printed models.
To maintain optimum printing, test the print heads, and calibrate them to the
best working configuration possible by running the Head Optimization
wizard. This procedure takes about one hour to complete.
If, during the optimization process, the wizard determines that a print head is
faulty—or that it is negatively affecting layer uniformity with the current head
configuration—the wizard instructs you to replace it. If this happens, you can
continue the wizard to replace the print head, or abort the wizard, to replace
the head at another time. This procedure takes about 2.5 hours more to
complete.
Run the Head Optimization wizard every 300 hours of printing or
whenever the condition of print heads is negatively affecting the quality of
printed models, or if you suspect that there is a problem with one or more
of the print heads.

To test and calibrate the print heads:
1. Prepare—
❒ isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒ disposable cleaning gloves (any clean, powder-free protective gloves)
❒ the supplied cleaning cloth or equivalent
❒ a mirror
❒ the Missing Nozzles ruler
❒ the scale supplied for use in the Weight Test
Ensure that the scale is calibrated and charged before beginning this
procedure.
2. Make sure that the type of material loaded in the printer is not Tango™
(flexible material).
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3. Start the Head Optimization wizard from the Options menu.

Figure 6-58 Starting the Head Optimization wizard
4. In the opening wizard screen, click Next to begin.
5. Close the printer cover, and confirm this in the wizard screen.
6. In the following screen, make sure Optimize all print heads is selected,
and click Next.

Figure 6-59 Procedure selection screen
The print block moves into position for cleaning and inspecting the print
heads.
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7. When the following screen appears, clean the print heads.

Figure 6-60 Clean print heads screen

Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch
them with your bare hands, and proceed with caution.
8. Place the mirror on the build tray.
9. Put on the cleaning gloves.
10. Soak the cleaning cloth with alcohol.
11. Clean the orifice plates, with a back-and-forth motion.
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-61 Cleaning the print heads
12. When the print heads are clean, select the confirmation check box in the
wizard screen and click Next.
13. Remove the cleaning materials and the mirror from the printer, and close
the cover.
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14. Confirm the items listed in the next screen, and click Next.

Figure 6-62 Confirmation screen
Make sure that the scale for weighing the printed samples is calibrated.
Inaccurate readings may result in print heads that are not optimized for
quality printing, or a false indication that a head needs to be replaced.
15. Select the confirmation check box in the wizard screen and click Next.

Figure 6-63 Printing Weight Test
The printer prepares itself for printing (by running the reinitaite process).
Then, 6 or 12 samples are printed on the build tray, depending on the
printer model. This can take up to 80 minutes.
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16. When the following screen appears, open the printer cover to inspect the
printed samples.

Figure 6-64 Data-entry screen for some Objet30 printers

Figure 6-65 Data-entry screen for Objet30 Pro printers
The layout of the data entry screen matches the printed samples on the
build tray. You enter the data for the sample indicated by in the screen.
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17. Using the Missing Nozzles ruler, determine the number of clogged
(“missing”) nozzles.

Figure 6-66 Missing Nozzles ruler
Clogged nozzles are seen in Weight Test samples as missing rows of
printed material.
a. Place the alignment line on the right side of the ruler next to the
bottom of the sample, as shown.

Figure 6-67 Aligning the ruler to the bottom of the sample
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b. Check if there is a space below the line on the ruler marked
“Maximum height of sample.”
A space below this line indicates missing nozzles at the extremes of the
printed sample. The numbers indicate how many printed rows
(nozzles) are missing. Remember this number.

Figure 6-68 Measuring missing nozzles at the extremes of the sample
Note: Because you align the ruler to the bottom of the printed sample,
missing nozzles at the bottom edge are measured at the top of the ruler.
c. Check if there are gaps in the printed sample by matching the gap in
the sample with a line on the Missing Nozzles ruler. The number on
the ruler next to the line indicates the number of missing
rows/nozzles.

Figure 6-69 Measuring a missing row in a printed sample
In the example above, the number of missing nozzles is two (2).

DOC-34022 Rev. D

6-49

Objet30 User Guide

6 Operating and Maintaining the Objet30 3D Printer

d. Enter the total number of missing rows in the wizard screen (in the
“missing nozzles” field).
Note: During this procedure, the roller does not smooth the surface of the
printed samples. Do not mistake the visible lines in the sample for missing
material.

Figure 6-70 Printed sample for Head Optimization
18. Carefully remove the sample, weigh it, and enter the weight in the wizard
screen.
Be sure to remove and weigh the entire sample, even if it breaks into
several pieces.
19. After entering the number of missing nozzles and the weight of the
sample, click Apply or press Enter.
The data-entry-indicator

moves to the next position.

20.Enter the data for all printed samples.
To change an entry, click Edit Data, enter the correct data, and click
Save.
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21. When you have entered the data for all printed samples, click Next.
The wizard uses the data collected to analyze the condition of the print
heads, and optimizes them so they print models with a uniform layer of
material.
❒ If the heads are in satisfactory condition, the following wizard screen
appears.1

Figure 6-71 Final wizard screen, after optimizing print heads
Note: To apply the optimized settings to the print heads, the printer
application must be restarted. When you click Done, the application closes
and re-opens.
❒ If the wizard determines that a print head is faulty—or that it is
negatively affecting model quality with the current head
configuration—the wizard instructs you to replace it. In this case, the
following screen appears.

Figure 6-72 Defective print heads found

1However, after optimizing print heads following their replacement, a screen appears enabling

you to continue by running the Head Alignment wizard (see page 35). This is necessary before
printing models.
If you choose not to align the heads at this time, the printer application closes and re-opens
when you click Done.
DOC-34022 Rev. D

6-51

Objet30 User Guide

6 Operating and Maintaining the Objet30 3D Printer

22. Choose Replace faulty head(s) if you are prepared to replace the print
heads now.
or—
Choose Abort wizard if you want to replace the print heads at another
time.
Replace print heads only after consulting with a Stratasysauthorized customer-support engineer.
To replace print heads, you need these tools and materials:
❒ replacement print head(s)
❒ isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒ disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)
❒ a supplied cleaning cloth or equivalent
❒ the scale supplied for use in the Head Optimization wizard (Weight
Test)
❒ the Missing Nozzles ruler
If you are replacing print heads now, the wizard guides you through the
procedure when you click Next. Continue with "Preparing the Print Block" on
page 6-54.

Replacing
Print Heads

The condition of the print heads directly affects the quality of printed models.
You may need to replace a print head if one or more of the following
symptoms occurs:
• The Head Optimization wizard determines that a print head is defective.
(See "Optimizing (Calibrating) Print Heads" on page 6-43.)
• There are noticeable grooves in the surface of printed models.
• Visual inspection of the head reveals that its surface is damaged—peeling
or bubbles in the nozzle area.
• The printer interface displays a warning or malfunction message relating
to a print head—
❒ Head Heater temperature timeout
❒ Head Heater thermistor open
❒ Head Heater thermistor short
Replace print heads only after consulting with an authorized
customer-support engineer.
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The Head Optimization wizard guides you through the procedure of replacing
a print head, and adjusts printer components to enable you to perform it.
Only replace a print head with the aid of the wizard. The entire procedure
takes about 2.5 hours, and consists of the following phases:
A. Identifying the head(s) needing replacement.
This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction message
indicates which head needs replacing.
B. Preparing the print block for head replacement.
This is done automatically when you run the wizard.
C. Removing the defective print head.
D. Installing a new print head.
E. Optimizing the print heads (done automatically by the wizard).
F. Performing head alignment.
To replace a print head:
1. Prepare—
❒ replacement print head(s)
❒ isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒ disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)
❒ a supplied cleaning cloth or equivalent
❒ the scale supplied for use in the Head Optimization wizard (Weight
Test)
❒ the Missing Nozzles ruler
Note: Make sure that you have these items and that the scale is calibrated
and charged before performing the head-replacement procedure.
2. Start the Head Optimization wizard from the Options menu (see
figure 6-38 on page 29).
3. In the opening wizard screen, click Next to begin.
4. In the following screen, select Replace faulty heads, and click Next.

Figure 6-73 Procedure selection screen
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Preparing the 5. Select the print head(s) needing replacement, and click Next.
Print Block

Figure 6-74 Head selection screen
The printer heats and empties the print block, and prepares the printer.

Figure 6-75 Printer preparation progress screen
6. The following screen appears when the printer is ready for you to replace
print heads.

Figure 6-76 Printer ready for head replacement
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7. Put on the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.

Figure 6-77 Print-head replacement confirmation
Removing the
Defective Head

To replace the Model print head, you must first remove the Support print
head.

Removing the Support Print Head
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➢ If you do not need to replace the Model print head, continue
with "Removing the Defective Head" on the previous page.

Removing the Model Print Head
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Installing the Model Print Head
➢ When re-installing a used print head, always replace the Oring seals with new seals.
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Installing the Support Print Head
➢ When re-installing a used print head, always replace the Oring seals with new seals.
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8. In the Replace print heads screen, select the check box to confirm that
you have replaced the head(s), and click Next.

Figure 6-78 Head replacement confirmation
9. Confirm that the heads are level and even by selecting the check box in
the following wizard screen, and click Next.

Figure 6-79 Installation-check screen
10. In the next wizard screen, confirm that you have removed all tools and
objects from the printer and that the cover is closed.

Figure 6-80 Cleared-tray confirmation screen
The wizard continues by heating the heads, then filling and purging them. If
there are no installation problems, the optimization procedure begins, to
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calibrate the print heads to the best working configuration—see "Optimizing
(Calibrating) Print Heads" on page 6-43. After this procedure, you should run
the Head Alignment wizard before printing models.
If installation problems are detected, the wizard alerts you and instructs you
how to continue (see "Installation Problems", next).
Installation If the printer detects that there is a problem after you install print heads,
Problems relevant warning screens appear.
• If the print head you installed is not new—that is, it was previously
removed from a printer—the following message appears.

Figure 6-81 Used print head message
❒ To continue with the installation of this print head, click Yes.
❒ To remove this print head and install a new one, click No.
• If the printer software does not detect the replaced head, the following
warning screen appears.

Figure 6-82 Incorrect-installation screen, showing which head(s) to reinsert
If this happens:
a. Re-insert the print-head driver card into its socket.
b. In the wizard screen, select the check box to confirm that you have reinserted the card, and click Next.
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The effective UV radiation from the lamp used for curing models can change
over time. Too little UV curing can cause some of the printing material to
remain in a liquid state, on models, when printing has finished. Test the lamp
and calibrate its effective UV radiation after every 300 hours of printing, or
when you suspect that this is necessary, by running the UV Calibration
Wizard.
The wizard compares the measured radiation to the recommended radiation
level. When calibrating the lamp, the wizard attempts to adjust the radiation
level, if necessary.
• If the reading is within the acceptable range, the wizard continues.
• If further adjustment is necessary, the test is repeated.
• If the UV radiation is too low to be properly adjusted, the wizard indicates
that the lamp’s radiation for the printing mode is unacceptable.
Before testing and calibrating the UV lamp, make sure the glass lens is
clean. For easy access, run the Head Cleaning Wizard, and use the
special cleaning pad supplied.

To test and calibrate UV lamp radiation:
1. Start the UV Calibration Wizard from the Options menu (see on page 631).
2. In the following screen, select UV Intensity Calibration to adjust the lamp’s
radiation level to the acceptable range.

Figure 6-83 UV Test/Calibration selection
3. Make sure that the build tray is clear (empty). Confirm this in the wizard
screen and click Next.
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The following screen appears.

Figure 6-84 Printer preparation
4. Expose the UV sensor by sliding its cover to the right, and check that the
glass is clean.

Figure 6-85 UV sensor exposed
5. If necessary, clean the glass over the UV sensor with a cleaning cloth and
alcohol (IPA).
Do not use the abrasive cleaning pad to clean the glass.
When you click Next, the UV lamp powers up and stabilizes. (This takes
several minutes.) Then, the print block passes over the sensor and the
wizard compares the measured radiation to the recommended level.

Figure 6-86 UV measurement progress
If the UV level measured is not acceptable, the wizard calibrates the UV
lamp by adjusting the current supplied to it, and then tests it again.
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When completed, the wizard displays the condition of the lamp, after
calibration.

Figure 6-87 Final condition of UV lamp—acceptable intensity level

Figure 6-88 Final condition of UV lamp—unacceptable intensity level
6. If the wizard cannot adjust the lamp to within the specified UV intensity
range, perform the following steps and run the wizard again before
replacing the lamp:
❒ Check that the UV-lamp glass is clean.
❒ Check that the UV sensor is completely uncovered and that the
protective glass is clean.
If the results are still unacceptable, contact customer support for further
advice.
7. Click Next, close the UV sensor cover, and confirm this in the wizard
screen. Then click Next to complete the wizard.
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Figure 6-89 Final UV Calibration Wizard screen

Calibrating the
Load cells are sensors that measure the weight of the material cartridges and
Load Cells

the waste container in the printer. It is important that you periodically check
that the weight measurements are accurate to prevent unnecessary waste of
printing materials. It is recommended that you calibrate the load cells after
500 hours of printing, or every six months.
To calibrate load cells:
1. Start the Load Cell Calibration wizard from the Options menu.
2. Select one or more load cells that you want to calibrate, and click Next.

Figure 6-90 Load cell selection
3. Remove the cartridge, as instructed by the wizard, and close the materials
drawer.
Important: Make sure that the materials drawer is closed before continuing.
Otherwise, calibration will be affected.
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4. Select the confirmation check box and click Next.

Figure 6-91 Confirmation of cartridge removal
5. In the next wizard screen, observe the numbers and wait until the level is
relatively stable—two units above or below the average level shown.

Figure 6-92 Level stabilization
6. Select the check box, and click Next.
If you need to calibrate more than one load cell, the next calibration
screen appears. Repeat steps 5 and 6 until all of the load cells are
calibrated.
7. Click Done in the final wizard screen.

Figure 6-93 Final wizard screen
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8. Replace the cartridge.
l

l

Replacing the
Odor Filter

When replacing the waste container, hold the waste bag with one hand
while connecting the waste tube. Otherwise, the bag will be twisted, and
the flow of waste will be restricted.
Make sure to replace the metal cover over the waste container. Operating
the printer without the cover results in an inaccurate measurement of the
waste weight, which will cause waste to overflow into the printer.

If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (as necessary) to keep your working
environment pleasant. This is normally done during the preventivemaintenance routine.
To replace the odor filter:
1. Locate the filter drawer at the rear of the printer and pull it open.

Figure 6-94 Rear of the cartridge printer
2. Remove the used filter. (You can push it out from underneath the drawer.)

Figure 6-95 Odor filter in drawer
3. Insert a new filter and close the drawer.
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The UV lamp used for curing models has a long, but limited, working life. You
can test and adjust its effective power with the UV Calibration wizard (see
"Testing and Calibrating the UV Lamp" on page 6-63). If you need to replace
the UV lamp, follow these instructions:
1. Start the UV Lamp Replacement wizard from the Options menu (see
"Starting the Material Replacement wizard" on page 6-14).

Warning
Before continuing, make sure that the safety interlock in the printer cover
is not defeated, and that the lamp is not hot.
2. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

Figure 6-96 “Empty tray” confirmation screen
The axes move to the “home” position.
3. On the UV-assembly cover, loosen (do not remove) the thumbscrew
indicated in the photograph below.

Figure 6-97 UV-assembly cover
4. Remove the other four (4) thumbscrews that secure the UV-assembly
cover, and remove the cover.
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5. Disconnect the UV lamp cable and the fan cable.

Figure 6-98 Disconnecting the UV lamp assembly (top view)
6. Loosen the two side screws securing the UV lamp assembly to the printer.

Figure 6-99 UV-lamp-assembly
7. Remove the assembly, and place it on a flat surface.
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8. Loosen the screws securing the UV lamp cover and remove the cover.

Figure 6-100 UV-lamp-cover screws
9. Loosen the two screws securing the UV reflector.

Figure 6-101 UV-reflector screws
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10. Remove the UV reflector by raising it slightly, then pulling it out of the
housing at an angle, from the bottom.

Figure 6-102 Removing the UV reflector from the UV assembly
11. Discard the old UV reflector and lamp.
Dispose of the used UV lamp in accordance with environmental and
safety requirements.

Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.
l
l
l

l

Ventilate the room thoroughly.
Use protective gloves when collecting mercury and lamp components.
Remove spilled mercury with a method that prevents the generation of
mercury vapor, such as a syringe, packing tape or paper.
Place the broken lamp, mercury and contaminated materials in an airtight, non-metallic container.

12. Insert the new UV lamp/reflector unit into the housing.
13. Make sure that the UV-lamp cable is in place, inside the housing, and then
tighten the securing screws.

Figure 6-103 Cable position when installing the UV lamp
14. Replace the UV lamp cover, and tighten the securing screws.
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15. Replace the UV lamp assembly in the printer, making sure that the cable
fits into the slot together with the side securing screw.

Figure 6-104 UV-lamp cable after replacing the assembly
16. Tighten the two side securing screws.
17. In the wizard screen, confirm that you have replaced the UV lamp and
that the black strip is attached, then click Next.

Figure 6-105 UV-installation confirmation screen
The wizard operates the lamp to test if it is installed correctly. If the lamp
does not light, the wizard prompts you to check the power connections
and to re-install the lamp.

Figure 6-106 Final wizard screen
Note: The UV lamp remains on until you click Done.
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After replacing the UV lamp:
l

l

Replacing the
Material Filter

Calibrate its power by running the UV Calibration wizard (see "Testing
and Calibrating the UV Lamp" on page 6-63). Wait at least two minutes
for the UV lamp to cool before starting the UV Calibration wizard.
Calibrate the new UV lamp again after 100 hours of printing.

The Model and Support filters are replaced during the periodic preventive
maintenance routine (see "Preventive Maintenance Tasks" on page 6-99).
The material filters are located at the back of the materials drawer, as shown
below.

Figure 6-107 Material filters
1. Prepare the following tools and materials:
❒ protective gloves
❒ cleaning cloths
❒ wire cutter
❒ paper towels
❒ two replacement filters and cable ties (supplied in the preventive
maintenance kit)
The Model and Support filters supplied in the preventive maintenance kit
are identical.
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2. Close the printer application.
3. Shut down the printer computer, wait 60 seconds after the monitor goes
blank, and turn off the main power switch.

Caution:
The monitor goes blank as soon as the remote desktop link terminates—
before computer shutdown. Turning off the printer before computer
shutdown can cause damage.
4. Put on protective gloves.

Warning: Toxic and Corrosive Materials
Prolonged contact with resins could cause skin irritation. Put on protective
gloves before continuing.
5. Open the materials drawer.
6. Remove the cover from the waste container.

Figure 6-108 Removing the waste container cover
7. Unscrew the cap connecting the waste-drain tube to the container.
8. Carefully lift out the container and remove it from the printer.
9. Place paper towels in the waste compartment to absorb any material leaks.
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10. Extend the materials drawer to the end of its track, as follows:
a. Push the drawer slightly inward.
b. Lift the extension latch and pull out the drawer, all the way.

Figure 6-109 Materials drawer extension latch
11. Remove the cable tie securing the Model and Support filters to the printer.

Figure 6-110 Material filters secured to the printer
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12. Disconnect the feed tube from the Model material filter, as shown.

Important:
To disconnect the feed tube, hold the fitting at the end of the tube in place and
turn the filter. Otherwise, the feed tube will be twisted and material might leak.

Figure 6-111 Model and Support material filters
13. Make sure that the fitting at the end of the feed-tube remains attached to
the tube. Re-attach it, if necessary.
14. Cover the filter with a cleaning cloth (or paper towels) to absorb material
spillage.
15. On the new filter, identify the side marked INLET.

Figure 6-112 Inlet side
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16. Attach the inlet side of the new filter to the disconnected tube.

Important:
To attach the filter, hold the fitting at the end of the feed tube in place and turn
the filter. Otherwise, the feed tube will be twisted and material might leak.
17. Disconnect the old filter from the outlet tube.
18. Discard the old filter

Caution:
The filter contains uncured printing material. Discard the filter in
accordance with applicable environmental regulations.
19. Cut and remove the cable tie securing the fitting at the end of the outlet
tube.

Figure 6-113 Tube with cable tie and fitting
20.Remove the fitting from the end of the tube.
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21. Attach the fitting to the new filter.

Important:
To attach the filter, hold the fitting at the end of the feed tube in place and turn
the filter. Otherwise, the feed tube will be twisted and material might leak.

Figure 6-114 Fitting attached to the new filter
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22. Attach the outlet tube to the fitting.
Make sure that the tube is firmly attached by pushing it onto the entire
length of the fitting shaft.

Figure 6-115 Tube attached to the new filter
23. Secure the tube to the fitting with a cable tie. Cut off excess length.

Figure 6-116 Tube secured with a cable tie
24. Repeat steps 2–13 to replace the Support filter.
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25. Wipe the filters, tubes and surrounding area to remove material leaks and
spills.
26. Position the filters in their slots.

Figure 6-117 Material filters positioned in the printer
27. Secure both filters to the printer with a long cable tie. Cut off excess
length.
To secure both filters properly, route the cable tie through the holes in the
filter holder (see Figure 6-117).

Figure 6-118 Filters secured in the printer
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To return the printer to operating mode:
1. Place the waste container in the materials drawer, and attach the cap
connected to the drain tube.

Important:
Hold the waste bag with one hand while attaching the waste tube. Otherwise,
the bag will be twisted and the flow of material will be restricted.

Figure 6-119 Attaching the waste drain tube
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2. Place the cover over the waste container, and make sure that the drain
tube is free and not bent.

Important:
Operating the printer without the waste container cover results in an
inaccurate measurement of the waste weight, which will cause waste to
overflow into the printer.

Figure 6-120 Cover installed on the waste container
3. Close the materials drawer.

Replacing the
Pump Tubes

Pump tubes in Objet30 Desktop V3 printers are replaced during periodic
preventive maintenance (see "Preventive Maintenance Tasks" on page 6-99).
To replace the pump tubes:
1. Prepare the following tools and materials:
❒ key
❒ flat screwdriver
❒ protective gloves
❒ cleaning cloths
❒ wire cutter
❒ three replacement tubes and cable ties
The three tubes supplied in the kit are identical; they can be used in the
pumps described in this section.
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2. Close the printer application.
3. Shut down the printer computer, wait 60 seconds after the monitor goes
blank, and turn off the main power switch.

Caution:
The monitor goes blank as soon as the remote link terminates—before
computer shut down.
Turning off the before the computer shutdown can cause damage.
4. Open the materials drawer.

Figure 6-121 Material pumps
5. Remove the three screws securing the right printer panel and remove the
panel.

Caution:
Remove the screws carefully so that they do not fall and scratch the printer
panel.

Figure 6-122 Removing the right printer panel
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6. Put on protective gloves.

Warning: Toxic and Corrosive Materials
Prolonged contact with resins could cause skin irritation. Put on protective
gloves before continuing.
7. Remove the cover from the waste container.

Figure 6-123 Removing the waste container cover
8. Unscrew the cap connecting the waste tube to the container.
9. Carefully lift out the container and remove it from the printer.
10. Place cleaning cloths in the waste compartment to absorb any material
leaks.
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11. Extend the materials drawer to the end of its track, as follows:
a. Push the drawer slightly inward.
b. Lift the extension latch and pull out the drawer, all the way.

Figure 6-124 Materials drawer
Waste Pump To replace the waste pump tube:
Tube
1. On top of the waste pump, locate the tube near the PRESSURE label.

Figure 6-125 Tubes connected to the waste pump
2. Label (mark) the tube.
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3. Carefully cut and remove the cable ties on the ends of the tube extending
from the pump.

Figure 6-126 Waste pump
4. Disconnect the tubes with their fittings from the ends of the tube
extending from the pump.
If you experience difficulty disconnecting the tube fittings from tubes in the
pump, make a small slit in the tube, as shown.

Figure 6-127 Tubes disconnected from the waste pump
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5. Release the tube latch, as shown.

Figure 6-128 Releasing the tube latch
6. Remove the pump tube with its holder from the pump assembly.

Figure 6-129 Removed tube and tube holder
7. Remove the tube from the tube holder and discard the tube.

Caution:
The tube contains uncured printing material. Discard it in accordance with
applicable environmental regulations.
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8. Attach a new tube to the tube holder.
Make sure that the tube extends equally on each side of the tube holder.
9. Insert the tube holder into the pump assembly.
10. Close the tube latch.
When the latch is closed, you should hear a clicking sound.

Caution:
Crimped tubes can cause material leaks that can damage the printer.
When securing the tube latch, make sure that you do not crimp (pinch) the
surrounding tubes.
11. Attach the tube you labeled in step 2 to the tube extending from the pump
near the PRESSURE label.
12. Attach the other tube to the tube extending from the pump near the
SUCTION label.
13. Secure each tube to its fitting with a cable tie. Cut off excess length.
14. Remove the label you attached in step 2.
Support Pump To replace the support pump tube:
Tube
1. Close the drawer approximately half way so that the Support pump is
accessible from the opening in the chassis on the right side of the printer.

Figure 6-130 Right side of printer
2. On the Support pump, locate the tube near the PRESSURE label.
3. Label (mark) the tube so that you can connect it correctly later on.
The replacement procedure is the same as for the waste pump. Continue with
step 2 on page 6-86.
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Model Pump To replace the model pump tube:
Tube
1. At the back of the Model pump, remove the screw shown below, using a
4-mm hex (Allen) key.

Figure 6-131 Model pump—securing screw to remove
2. Loosen (do not remove) the other securing crew.

Figure 6-132 Model pump—securing screw to loosen
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3. Turn the Model pump assembly so that the pump is facing you.

Figure 6-133 Model pump assembly turned
4. On the top of the Model pump, locate the tube near the PRESSURE label.
5. Label (mark) the tube.
The replacement procedure is the same as for the waste pump. Continue with
step 2 on page 6-86, and then return the pump to its working position.
To return the Model pump to its working position:
1. Turn the Model pump so that it is facing the drawer.
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2. Secure the Model pump to the printer with two screws.
Insert and tighten the securing screw you removed before, and tighten the
screw that you loosened.

Figure 6-134 Model pump in the working position
Returning To return the printer to working order:
Printer to
Working Order 1. Remove the cleaning cloths from the waste compartment and make sure
that the compartment is clean.
2. Place the waste container in the materials drawer, and attach the cap
connected to the drain tube.

Important:
Hold the waste bag with one hand while attaching the waste tube. Otherwise
the bag will become twisted, and the flow of material will be restricted.

Figure 6-135 Waste container with waste tube attached
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3. Place the cover over the waste container, and make sure that the drain
tube is free and not bent.

Important:
Operating the printer without the waste container cover results in an
inaccurate measurement of the waste weight, which will cause waste to
overflow into the printer.

Figure 6-136 Cover installed on the waste container
4. Attach the right printer panel.
Make sure that the materials drawer is open while you attach the panel.
5. Close the materials drawer.
6. Make sure that the right panel and the drawer are aligned properly.
7. Switch on the printer.

Important:
Switching on the printer activates the waste pump and stops working when
you open the printer application. If you hear unusual noises from the pumps
when switching on the printer, verify that the waste pump tube holder is
installed properly. If necessary, remove the tube holder and re-install it.
8. Open the printer control application.

Important:
If you hear unusual noises from the area of the pumps during printing verify
that the Model pump or Support pump tube holders are installed properly. If
necessary, remove the tube holders and re-install them.
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A sanity check of the software parameters is available from the Built-in Tests
interface. Because this affects the operation of the printer, you can only open
the Built-in Tests interface when the system is not printing.

Accessing
Built-in Tests To open the Built-in Tests screen, do one of the following:
• From the Options menu, select Built-In Tests.
• Press Ctrl+Alt+B.

Figure 6-137 Selecting Built-In Tests from the Options menu
The Built In Tests screen lists pre-configured tests.

Figure 6-138 Built In Tests screen
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Status
The “S” column shows the results of the test after you run it:
Test successfully completed.
Test failed.
Unknown results. (The test has not been run yet.)

To run the test:
➢ Select the check box and click

.

After you run the test, the Save and View command buttons are added to the
Built In Tests screen.

Figure 6-139 BIT command buttons
Test Results To save and view a report of all tests:
➢ Use the Save and View command buttons.
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Printer waste contains partially cured polymeric material, collected during
normal operation and maintenance of the printer. For safety and
environmental reasons, this material is kept in a special leak-proof, disposable
container.
The container has a capacity of 1.8 kilograms of waste material—usually
enough for several weeks of printer use. The printer application displays a
warning message when there are 1.5 kilograms of material in the container,
and stops the printing when the net weight reaches 1.8 kilograms. Above 1.5
kilograms, the software does not allow you to start a printing job or activity
until you replace the waste container. You can monitor the weight of the
waste container in the Maintenance screen of the printer interface.
To monitor the waste weight (and other indicators) in the printer:
➢ In the main printer interface screen, click the display toggle to view the
printer indicators.

Figure 6-140 Printer interface, showing waste weight (red background
indicates operator alert)
The waste container consists of a sealed bag inside a cardboard box. You
typically dispose of the entire waste container—including the box. Therefore,
you must assemble a new box and insert a new waste bag before you can
install it in the printer.
Replacement boxes, waste bags, and sealing caps are supplied in the
Objet30 printer start-up kit and in the preventive-maintenance kit.

DOC-34022 Rev. D

6-96

Objet30 User Guide

6 Operating and Maintaining the Objet30 3D Printer

To prepare a new waste container:
1. Assemble the cardboard box, making sure to punch out the perforated
sections.
2. Fold a new waste bag—so it fits in the box—and insert the bag’s screwconnector into the hole in the top of the box.
Note: Do not close the box until you connect the waste drain tube from the
printer.
To replace the waste container:
1. Open the materials drawer.
2. Remove the fireproof cover from the waste container.

Figure 6-141 Removing the waste-container cover
3. Unscrew the cap connecting the waste drain tube to the container.
4. Carefully lift out the waste container to remove it from the printer.
5. Close the full container with the cap supplied with the new waste
container.
6. Place the new waste container in the materials drawer, and attach the cap
connected to the drain tube.
Important: Hold the waste bag with one hand while attaching the waste
tube. Otherwise, the bag will be twisted, and the flow of waste will be
restricted.
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7. Close the new waste-container box.

Figure 6-142 Waste container with drain tube attached
8. Place the fireproof cover over the waste container, making sure that the
drain tube is free and not bent.

Figure 6-143 Fireproof cover installed over the waste container
Note: Operating the printer without the waste-container cover results in an
inaccurate measurement of the waste weight, which will cause waste to
overflow into the printer.
9. Close the materials drawer.
Dispose of the full waste container in accordance with environmental and
safety requirements.
The painted exterior plastic panels of Objet30 3D printers have a durable
Cleaning the
Exterior Panels finish, offering excellent chemical resistance to common cleaning materials.
However, it is recommended that you use only a mild soap solution for
routine cleaning.
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Printer modes and configuration settings are stored in files on the printer
computer. You can back up these files, and restore them, if necessary, using
desktop icons.

Figure 6-144 Backup and restore desktop icons

ReInitiate
Wizard

One of the wizards listed in the Options menu is ReInitiate. You normally do
not have to run this wizard. The process that this wizard controls runs
automatically, when needed, as part of the Pre-print mode (before printing
begins). Run this wizard only if a Stratasys Customer Support engineer
instructs you to do so.

Preventive
Maintenance
Tasks

Performing regular preventive maintenance improves system reliability,
reduces downtime, and prolongs the life of your system. Perform the tasks
listed below once a year, or every 1000 printing hours, whichever comes first.
Performing these tasks on schedule:
• improves system reliability
• reduces system downtime and costly repairs
• protects and prolongs the life of your system
The first preventive maintenance (after purchase) is performed by a
Stratasys Service Engineer.
Note: To perform Preventive Maintenance routine, you will need the Preventive
Maintenance kit. To order the Preventive Maintenance kit, contact your Stratasys
service provider.
Use the following checklist to perform the preventive maintenance routine.
Odor Filter

o Replace the odor filter.
See "Replacing the Odor Filter" on page 6-68.
Wiper Assembly

o Clean the area surrounding the wiper.
o Replace the wiper.
See "Cleaning and Replacing the Wiper" on page 6-31.
Materials Drawer

o Calibrate all the load cells.
See "Calibrating the Load Cells" on page 6-66.

o Replace the waste container.
See "Replacing the Waste Container" on page 6-96.
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o Replace the Model and Support material filters.
See "Replacing the Material Filter" on page 6-74.

o Replace the Model, Support and Waste material pump-tubes.
See "Replacing the Pump Tubes" on page 6-83.
Roller Waste Collector

o Replace the roller waste collector.
See "Cleaning and Replacing the Roller Waste Collector " on page 6-36.
UV Lamp

o Replace the black strip in the UV reflector.
See "Replacing the UV Lamp" on page 6-69.

o Clean the glass lens of the UV lamp assembly with the special 3M
cleaning pad.
o Clean the glass covering the UV sensor (to the right of the build tray).
o Calibrate the UV lamp intensity
See "Testing and Calibrating the UV Lamp" on page 6-63.
Print Heads

o Clean the print heads with the Head Cleaning Wizard
See "Cleaning the Print Heads and the Roller" on page 6-28.

o Perform the Pattern Test
See "Pattern Test" on page 6-33.

o Check the alignment of the print heads
See "Aligning the Print Heads" on page 6-39.

o Run the Head Optimization Wizard
See "Optimizing (Calibrating) Print Heads" on page 6-43.
Printer Software

o Run a sanity check of the printer parameters
See " Built-in Tests" on page 6-94.

o On the printer computer desktop, click BackupData.
This saves a backup copy of the Modes and Configs files.

o Restart the printer and server computers.
UV Sensor Calibration

o The UV sensor should be calibrated once every two years. If two years
have passed since the last service visit, contact Stratasys to request
UV sensor calibration.
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Removing Models After Printing
After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on the
printer, it is best to let the printed models cool in the printer, with the cover
closed, as long as possible.
If the printer must be used to produce additional models as soon as possible:
1. Let the printed models cool on the build tray for at least 10 minutes.
2. Very carefully, remove the models from the tray with a scraper or spatula
(supplied in the tool kit), taking care not to pry or bend the model.

Warning:
Wear protective gloves when handling printed models before they are
washed.
3. Place the models on a flat surface, and cover them with a cardboard box
or paper hood.
This allows the models to cool slowly and evenly.
4. Let the models cool for several hours.

Removing the Support Material
After printed models have cooled, the support material must be removed. This
can be done by different methods, depending on the size of the model, how
delicate it is, the amount and location of the support material, and other
factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.
SUP705 (FullCure705) can be removed from printed models using the
following methods, in this order:
1. by hand
2. water pressure (in a suitable cleaning unit)
3. 1% caustic soda solution (recommended for a smooth finish)
Removing While wearing protective gloves, break away excess support material on the
Excess Support outside of the model. For delicate models, use a toothpick, pin or small brush
Material by after dipping the model in water.
Hand
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Removing For most models, the most efficient way to remove support material is by
Support Material using a high-pressure water jet. One suitable system is the Objet WaterJet
with Water cleaning unit.
Pressure

Figure 7-1 Objet WaterJet Cleaning Unit
To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump turns
ordinary tap water into a high-pressure jet, and a wiper keeps the window
clear.
Use caution when cleaning delicate models with high-pressure water
systems.
Removing Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to
SUP705 with remove support material from difficult-to-reach areas and to give the model a
Caustic Soda smooth, clean finish. The amount of time you soak the model in the solution
depends on how delicate it is and how much support material needs to be
removed, but it is typically between half-an-hour and several hours. In any
case, you should remove as much support material as possible before the
caustic soda treatment, and rinse the model thoroughly (with a water jet)
afterwards.

Warning
Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour
water into caustic soda. When diluting the solution, always add caustic
soda to water. Take adequate safety precautions; always use nitrile
gloves when handling caustic soda and models soaked in it.
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Post-Printing Treatment for Models Made with VeroClear
Models made with VeroClear (RGD810) have a slight yellow tint when
removed from the printer. This is especially true for models printed with a
glossy finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.
As a rule, best clarity is achieved when parts are printed with a matte finish,
and treated as explained below.
Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

Figure 7-2

PhotoBleaching
Instructions

Left: Illumination chamber; Right: Desk lamps

Follow these instructions for photobleaching printed models.
• The fluorescent lamps should be rated 45W, 6500K.
• When using desk lamps, place the models in a container lined with
aluminum foil. Use at least two lamps, more when treating models in a
large container.
• Arrange the models with enough space between them to allow light to
reach all sides of each model.
• Verify that the ambient temperature around the models is approximately
40°C (104°F). Higher temperatures may cause model distortion; lower
temperatures may not produce satisfactory results. When using desk
lamps, you can achieve the required temperature by positioning the lamps
approximately 10 cm (4 in.) above the models.
• Inspect the models after six hours of treatment.
❒ For parts with a matte finish, this should be enough. Polish and
lacquer the parts.
❒ For parts with a glossy finish, continue the photobleaching treatment
for up to 18 hours more.
In Stratasys laboratories, there was a tint reduction of approximately 70%
within six hours. After 24 hours, tint was reduced by approximately 90%.
More information about this treatment is available in the application note
VeroClear RGD810 Model Material.
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Storing Models
Models are cured as they are printed, making them safe and stable for a long
time. However, proper storage conditions are necessary to prevent deforming.
• Keep printed models at room temperature and in a low-humidity
environment.
• Do not expose models to direct sunlight and other heat sources.
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